Differential Effects of the Manipulation of Endoplasmic Reticulum Data Sets Using Image J Analysis Software for Conceptual Understanding in a College Biology Course

Copyright 2010 Cleveland O. Lane, Jr.
DIFFERENTIAL EFFECTS OF THE MANIPULATION OF ENDOPLASMIC
RETICULUM DATA SETS USING IMAGE J ANALYSIS SOFTWARE FOR
CONCEPTUAL UNDERSTANDING IN A COLLEGE BIOLOGY COURSE

A Dissertation

by

CLEVELAND O. LANE, JR.

Submitted to the Office of Graduate Studies of
Texas A&M University
in partial fulfillment of the requirements for the degree of

DOCTOR OF PHILOSOPHY

Approved by:

Chair of Committee, Carol L. Stuessy
Committee Members, Cathleen C. Loving
                      Robert M. Capraro
                      Larry R. Griffing
Head of Department, Dennie L. Smith

December 2010

Major Subject: Curriculum and Instruction
ABSTRACT


Cleveland O. Lane, Jr., B.S., Prairie View A&M University; M.S., Prairie View A&M University

Chair of Advisory Committee: Dr. Carol L. Stuessy

There has been an influx of funding in science, technology, engineering and mathematics (STEM) allocated to adapting educational systems that engage, motivate and train learners with new and innovative techniques.

This exploratory research project investigated the student outcomes associated with undergraduate biology learner' engagements in the ER Project. Thirty-one students interacted in small groups within an inquiry-learning environment supported by an innovative technology that introduced a database of images of green florescent endoplasmic reticulum and golgi apparatus. The aim of the ER Project was to increase learners' conceptual understanding of cell structure and movement and engage in scientific processes in an authentic inquiry setting.

To identify relationships between and among independent and dependent variables in a causal model hypothesizing relationships among Prior Knowledge,
Learning Preference, Attitudes toward Computers, Inquiry Task Performance and Conceptual Understanding were tested using path analysis.

The study found that while prior knowledge was a strong predictor for conceptual understanding, it was not as effective for observing the inquiry task performance. But, the Motivation towards Computers and their Inquiry Task Performance indicated that learners understood the scientific processes and were able to communicate their results.
DEDICATION

To all those who have contributed to who I am
ACKNOWLEDGEMENTS

I want to express my gratitude to everyone who has had a part in my formal and informal educational experiences, from grade school through college. You have all contributed to the development of me as a young man with a thirst for knowledge.

I also want to thank Dr. Janie Schielack (NSF) for providing me support through the Center for Information Technology in Science.

I also thank my committee members, Dr. Larry Griffing, Dr. Cathy Loving, Dr. Robert Capraro, for providing guidance in my coursework and dissertation. In addition, a special thanks to Dr. Griffing for letting me work on the ER Project for my dissertation.

I owe my deepest gratitude to my committee chair, Dr. Carol Stuessy, who has been a mentor and friend throughout this quest to attain this degree. You have been very vital to me.

I have to thank my parents, siblings, grandparents, great grandparents and all of my family members for being there supportively, financially and emotionally. You all have contributed to my perseverance, patience and understanding of the importance of education.

I would like to thank all of my students, who have encouraged me during this process. You truly provided me with unyielding support.

Last, but certainly not least, I would like to thank my GIRLS, Perla my wife, and Jayla and Jada, my daughters, for your Understanding, Love and Encouragement.
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABSTRACT</td>
<td></td>
<td>iii</td>
</tr>
<tr>
<td>DEDICATION</td>
<td></td>
<td>v</td>
</tr>
<tr>
<td>ACKNOWLEDGEMENTS</td>
<td></td>
<td>vi</td>
</tr>
<tr>
<td>TABLE OF CONTENTS</td>
<td></td>
<td>vii</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td></td>
<td>xi</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td></td>
<td>xii</td>
</tr>
<tr>
<td>I INTRODUCTION</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Need for the Study</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Purpose of the Study</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Problem Statement</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Research Questions</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Significance of the Study</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>Framework of the Study</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>Definition of the Variables</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>Variables Considered in This Study</td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>Limitations of Study</td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>Summary Statement of Chapter I</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>II LITERATURE REVIEW</td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>Conceptual Framework</td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>Rationale</td>
<td></td>
<td>17</td>
</tr>
<tr>
<td>Complexity in Living Systems</td>
<td></td>
<td>17</td>
</tr>
<tr>
<td>Synergy between Scientific Research and the Education Community</td>
<td></td>
<td>19</td>
</tr>
<tr>
<td>Deep Conceptual Understanding about Significant Scientific Ideas</td>
<td></td>
<td>21</td>
</tr>
<tr>
<td>Core Design Elements</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>Inquiry Learning</td>
<td></td>
<td>26</td>
</tr>
<tr>
<td>CHAPTER</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Innovative Technology Application</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>Mediatory Student Variables</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Student Differences</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Prior Knowledge</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Learning Preferences</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>Attitudes toward Computers</td>
<td>47</td>
<td></td>
</tr>
<tr>
<td>Path Analysis</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>The Model</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>Path Diagram</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>Variables of the Path Analysis</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>Path Coefficients</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>Analysis of the Causal Model</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>Summary of Chapter II</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>III METHODS</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>Research Design</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>Research Questions</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>Context for the Study</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>Participants</td>
<td>67</td>
<td></td>
</tr>
<tr>
<td>The Intervention</td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>Administrative Techniques</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>Statistical Analysis</td>
<td>72</td>
<td></td>
</tr>
<tr>
<td>Preliminary Analysis</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>Correlation Analysis: Question I</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>Regression Analysis: Question II</td>
<td>74</td>
<td></td>
</tr>
<tr>
<td>Summary of Chapter III</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>IV RESULTS</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>Instrument Description</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>Testing Question I</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>Summary for the Results of Question I</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>Testing Question II</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>Calculating the Structure Coefficients for the Predictor Variables</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>Testing the Hypothesized Path Diagram</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>Summation of Procedures Resulting in Path Coefficients</td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>Post Hoc Analysis</td>
<td>87</td>
<td></td>
</tr>
<tr>
<td>Summary of Chapter IV</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>V DISCUSSION OF THE RESULTS: CONCLUSIONS, IMPPLICATIONS AND RECOMMENDATIONS</td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>CHAPTER</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Goal ...............................................................................................</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>Review of Results ...........................................................................</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>Learner's Characteristics: Prior Knowledge, Learning Preference, Motivation toward Computers</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>Outcomes: Inquiry Task Performance and Conceptual Understanding ........</td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>Prior Knowledge .............................................................................</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>Overview .......................................................................................</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Questions I and II .........................................</td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Results ................................................................</td>
<td>104</td>
<td></td>
</tr>
<tr>
<td>Conclusion ....................................................................................</td>
<td>104</td>
<td></td>
</tr>
<tr>
<td>Learning Preference .......................................................................</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Overview .......................................................................................</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Questions I and II .........................................</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Results ................................................................</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Conclusion ....................................................................................</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Motivation toward Computers ........................................................</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Overview .......................................................................................</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Questions I and II .........................................</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Results ................................................................</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Conclusion ....................................................................................</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Conceptual Understanding .............................................................</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>Overview .......................................................................................</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Questions I and II .........................................</td>
<td>108</td>
<td></td>
</tr>
<tr>
<td>Discussion of the Results ................................................................</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Conclusion ....................................................................................</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Path Diagram ...................................................................................</td>
<td>109</td>
<td></td>
</tr>
<tr>
<td>Discussion and Implications ........................................................</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Future Recommendations ..................................................................</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>First Recommendation .....................................................................</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>Second Recommendation ..................................................................</td>
<td>114</td>
<td></td>
</tr>
<tr>
<td>Third Recommendation ....................................................................</td>
<td>115</td>
<td></td>
</tr>
<tr>
<td>Fourth Recommendation ...................................................................</td>
<td>116</td>
<td></td>
</tr>
<tr>
<td>Fifth Recommendation .....................................................................</td>
<td>116</td>
<td></td>
</tr>
<tr>
<td>Sixth Recommendation .....................................................................</td>
<td>116</td>
<td></td>
</tr>
<tr>
<td>Seventh Recommendation ..................................................................</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>REFERENCES ......................................................................................</td>
<td>118</td>
<td></td>
</tr>
<tr>
<td>Supplemental Sources Consulted ...................................................</td>
<td>125</td>
<td></td>
</tr>
<tr>
<td>Appendix</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>APPENDIX A</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>APPENDIX B</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>APPENDIX C</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>APPENDIX D</td>
<td>139</td>
<td></td>
</tr>
<tr>
<td>APPENDIX E</td>
<td>149</td>
<td></td>
</tr>
<tr>
<td>VITA</td>
<td>150</td>
<td></td>
</tr>
</tbody>
</table>
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Conceptual Model for Organizing the Literature Review</td>
<td>16</td>
</tr>
<tr>
<td>2</td>
<td>Image of <em>ER Project</em> Data Set</td>
<td>69</td>
</tr>
<tr>
<td>3</td>
<td>Captured Image of <em>Image J</em></td>
<td>70</td>
</tr>
<tr>
<td>4</td>
<td>Image of ROI with <em>ER Project</em> Data Sets</td>
<td>70</td>
</tr>
<tr>
<td>5</td>
<td>A Revised Model for Conceptual Understanding displaying Hypothesized paths</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>between variables that were tested by Path Analysis Techniques</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Resulted Model for Conceptual Understanding with the Meditative Inquiry</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Task Performance and Predictors</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Post Hoc Path Diagram of Predictor Variables, Inquiry Task</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Performance and Conceptual Understanding</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Simplified Model for Conceptual Understanding with the Meditative Inquiry</td>
<td>102</td>
</tr>
<tr>
<td></td>
<td>Task Performance and Predictors</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Post Hoc Path Diagram indicating Relationships of Predictor Variables:</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Prior Knowledge, Visual Learning Preference, and Motivation Towards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Computers, on Inquiry Task Performance and Conceptual Understanding</td>
<td></td>
</tr>
</tbody>
</table>
LIST OF TABLES

<table>
<thead>
<tr>
<th>TABLE</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List of Variables, Instruments and Sources</td>
</tr>
<tr>
<td>2</td>
<td>List of Variables, Instruments and Validity/Reliability</td>
</tr>
<tr>
<td>3</td>
<td>Descriptive Statistics for the Variables</td>
</tr>
<tr>
<td>4</td>
<td>Correlation Matrix of the Variables</td>
</tr>
<tr>
<td>5</td>
<td>Adjusted ( R^2 ), Beta Weights and Structure Coefficients</td>
</tr>
<tr>
<td>6</td>
<td>Path Coefficients for Path Diagram</td>
</tr>
<tr>
<td>7</td>
<td>Post Hoc Path Coefficients for Path Diagram</td>
</tr>
<tr>
<td>8</td>
<td>Post Hoc Best Fit Model Summary</td>
</tr>
</tbody>
</table>
CHAPTER I
INTRODUCTION

When learning is active, the learner is seeking something, an answer to a question, information to solve a problem, or a way to do a job. Learning can’t be swallowed whole. To retain what has been taught, students must chew on it.

-Mel Silberman

The National Science Foundation’s *Science and Engineering Indicators* (National Science Board, 2000) predicted the number of jobs for biological and medical scientists would grow from 110,000 in the year 2000 to 135,000 in 2010 (National Research Council, 2003, p. 22). The need to maintain the current number of scientists while encouraging the growth of new scientists is critical. Being viewed as global, the scientific workforce must be competent to fill these positions, which will require individuals who understand the content while being technologically proficient in a multicultural environment. To fill this growing need for researchers, there has been an influx of funding in science, technology, engineering and mathematics (STEM) allocated to adapting educational systems that engage, motivate and train learners with new and innovative techniques. This influx in STEM areas will also be used to compensate for the estimated need for 280,000 new science and mathematics teachers between now and 2015 to keep up with teacher attrition as well as growth in population (Epstein, 2007).

Biology has continued to be a discipline on the forefront of many of the currently researched social issues at local, national and global levels. These issues range...
from meningitis outbreaks to stem cell research. To research these areas, “Biological concepts, models, and theories are becoming more quantitative, and the connections between the life and physical sciences are becoming deeper and stronger. As a result, the predictive power of biology is also increasing swiftly” (National Research Council [NRC], 2003, p.10). The Human Genome Project, DNA fingerprinting, and cancer research are a few of the many areas in biology that have caused an escalation of information, techniques and equipment. As biological information continues to advance, the transfer of newly developed information to potential learners in the classroom has produced a need for more efficient methods of instruction. The production of more efficient and innovative forms of instruction has called for a reform of K-16 curriculum and instruction.

Need for the Study

Researchers and scientists acknowledge the need for reform in science education curriculum. Together they have addressed pedagogical changes and addition of technology into instruction as reform strategies (American Association for the Advancement of Science [AAAS], 1993; Bransford, Brown & Cocking, 2000; NRC, 2003) There are multiple factors that have stimulated the call for change in science instruction that stem from recent research on the limitations of traditional instruction in developing scientifically literate students (Donovan & Bransford, 2005). Another factor is technology development, which contributes to the scientific disciplines causing adaptability to instruction and students. Additionally, some of the curricula changes discussed in the researched reform of science education have included the use of inquiry-
based instruction, engaging learners’ prior knowledge and misconceptions, and more effective use of technology in the classroom. Moreover, the push for reform is needed to increase the number of research scientists and science teachers in the work force (NRC, 2003). The methods to address these challenges can be formulated from the following articles and books.

The book *How People Learn*, identified inquiry curricula as having an influence on the conceptual understanding and development of more competent learners (Bransford et al., 2000). It also suggested this is achieved by addressing the following student and instructional characteristics:

1. Students come to the classroom with preconceptions about how the world works. If their initial understanding is not engaged, they may fail to grasp the new concepts and information they are taught, or they may learn for the purposes of a test, but revert to their preconceptions outside the classroom.
2. To develop confidence in an area of inquiry, students must (a) have a deep foundation of factual knowledge, (b) understand facts and ideas in the context of conceptual framework, and (c) organize knowledge in ways that facilitates retrieval and application.
3. A *metacognitive* approach to instruction can help students learn to take control of their own learning by defining learning goals and monitoring their progress in achieving them (p.10).

As these instructional environments address such issues, the independencies of the learners increase, which causes learners to take ownership of their learning preferences
and methods of manipulating of information.

Specifically focusing on collegiate instruction, the National Science Teachers Association (NSTA) has published a guide for instructors to enhance science education standards in the college classroom to increase student-centeredness and inquiry-based learning environment (Siebert & McIntosh, 2001). They have also supported the alignment of instruction with the authentic practices of scientists, researchers, and engineers, providing authentic usage of professional knowledge content and technological influences. Learners must be placed in “environments that encompasses much more than the recall of facts or the application of procedural knowledge” (Horwitz & Christie, 2000, p.164)

The National Science Education standards “envisioned technologies promoting more meaningful learning by extending and expanding explorations throughout the science curriculum. They emphasize the need for technology in conjunction with inquiry, to promote students understanding of scientific concepts and not simply reinforce the ritualistic manipulation” (NRC, 1996, p.52). This deviation from traditional instruction has created a challenge for instructors, since the focal point of instruction has been to increase students’ abilities to understand, process, and apply scientific information. The use of computers and other technologies can alleviate some of the pressures on instruction and enhance learners’ scientific literacy.

In the natural sciences, approximately 86 percent of faculty reported lecturing as their primary method of instruction (NRC, 2003). Revised teaching approaches centered on a more hands-on approach are recommended in order to appeal more to students,
encourage them to obtain a scientific career, and develop new scientific abilities.

**Purpose of the Study**

The purpose of this study is to make both theoretical and practical contributions to the field of undergraduate science education. In this contribution, I aim to develop a learning environment similar to the framework presented by Bransford et al., (2000). This environment will be learner-centered, knowledge-centered, assessment-centered and community-centered. It will engage learners through the development of an inquiry-learning environment supported by an innovative technology that will introduce a database of images of green fluorescent Endoplasmic reticulum and Golgi apparatus. The aim is for the learners to understand cell structure and movement and scientific processes in an inquiry setting. I will also observe the relationship of learners’ personal characteristics while using technology-supported inquiry environments when learning current biological concepts.

**Problem Statement**

The problem addressed in the present research is to develop and analyze a model for student learning in an environment that is innovative, technology rich, and inquiry based. The model includes students’ prior knowledge, learning preference, attitudes towards computers students’ performance on an inquiry task, and a conceptual understanding outcome.

**Research Questions**

This study is guided by the following research questions:
1. What are the simple relationships existing between variables chosen for examination in the present study?

2. What are the direct and indirect effects of the variables included in this study on students’ Inquiry Task Performance and Conceptual Understanding?

**Significance of the Study**

The significance of this study resides in the context developed for investigation. The context uses an inquiry situation to foster students’ development of rich understandings about scientific knowledge. The design of tasks within the context prepares students to participate in social practices valued by the science community (Lee & Songer, 2003). The introduction of data sets of fluorescent images of the cell provides learners the opportunity to engage in use of authentic research data for analytical purposes. In addition, learners participate in the scientific processes often experienced by researchers. Participation and innovation can help translate or transfer the often-unattainable experiences of laboratory work to the undergraduate classroom. The use of data sets in an inquiry setting brings learners to a closer replication of authentic research in an “authentic science learning” environment (Edelson and Gordon, 1998). Inquiry and technology provides learners with situations that “bring real world problems into classroom, provide scaffolding, increase learning feedback, building learning communities and expanding opportunities for teaching learning” (Bransford et al., 2000, p. 243).

**Framework of the Study**

The design of this study combines resources from the learning sciences. The
seminal works of Donovan & Bransford (2005), Edelson, Gordon & Pea (1999) and Chinn & Malhotra (2002) have all made contributions to the development and assessment of technology supported inquiry instruction. Their frameworks are outlined in three parts: (1) components for the learning environment, (2) characteristics of learners that may be challenged, and (3) assessment of an inquiry environment.

Donovan and Bransford’s (2005) work provided the framework for developing an inquiry environment that enhances the science learner, in addition to technology contributions. The design of the instructional module tried to achieve the basic characteristics of being learner-center, knowledge-center, assessment centered and community centered. In attaining them, the module would engage students’ “initial understanding, promote construction of a foundation of factual knowledge in the context of a general conceptual framework, and encourage the development of metacognitive skills with the assistance of technology” (p. 256). The work of Edelson et al. (1999) and Chinn & Malhotra (2002) were used to develop and analyze the authentic science-learning environment. Edelson et al. (1999) discussed and considered common barriers to learning in a technology-supported inquiry-learning environment. Common barriers included misconceptions, engagement /motivation and students’ learning preferences. The framework was designed to eliminate these barriers in the design of the innovative inquiry project. Chinn and Malhotra (2002) identified the characteristics needed to provide an effective authentic science inquiry projects. These authors provided a scale for evaluating the effectiveness of an inquiry environment.
Chapter I illustrates the philosophical framework innovation through inquiry learning and technology. Chapter II provides a literature review for inquiry instruction, prior knowledge, learning preferences, attitudes toward computers and innovative technology for instruction. Methods used to collect data are presented in Chapter III along with research questions. Chapter IV describes research results in narrative and with graphics. Finally, Chapter V seeks to interpret and explain the results and discuss implications of the findings.

**Definition of the Variables**

Prior Knowledge- This term has particularly been recognized as an important attribute because it can influence how learners select information to place in memory and link new information to that already stored in memory. According to Johnson and Lawson (1998), learners build a hierarchically organized internal framework of specific concepts, each of which (or some combination of which) permits them to make sense out of new experiences.

Learning Preferences- This term is considered to include a range of constructs describing variations in the manner in which individuals learn. Trindade, Fiolhais & Almeida (2002) noted that Felder and Silvermann (1998) developed a scheme that classified the learning preferences preferred by engineering teachers and students into five groups (sensory/intuitive, visual/verbal, inductive/deductive, active/reflective, and sequential/global). The authors concluded that the teaching styles of most teachers do not match the learning preferences of most students. “Students learn better from processes which are sensory, visual, inductive, and active, while lectures tend to be
verbal, deductive, and passive” (p. 472).

Attitudes toward Computers- This term refers to the participant’s viewpoint of using computers, if anxiety develops or if confidence persists as the participant uses the computer.

Scientific Inquiry- This term refers to the “diverse way in which scientists study the natural world and propose explanations based on the evidence derived from their work. Inquiry also refers to the activities of students in which they develop knowledge and understanding of scientific ideas, as well as an understanding of how scientists study the natural world” (NRC, 1996, p. 23).

Conceptual Understanding- This term refers to the manner in which students are able to create explanations, make predictions, and argue from evidence. Conceptual understanding questions probe students’ knowledge of essential scientific concepts, including facts, events, principles, laws, and theories (Schneider, Krajcik, Marx & Soloway, 2002).

**Variables Considered in This Study**

Table 1 lists the variables considered for a sample population of biology undergraduates. A brief discussion of the variables and their corresponding instruments follows:
Prior Knowledge- For the purposes of this study, prior knowledge of biology was assessed by a 55-item multiple-choice test subsequently referred to as *biology pre-test*. Items were drawn from two test banks that accompanied an introductory general biology textbook. The instrument was administered during laboratory class as a pencil and paper exam. To establish face validity, copies of the test were sent to three experienced biology instructors, who were asked to judge the suitability of the test items. A copy of the questionnaire can be found in the Appendix A.

Learning Preference- The Visual, Auditory, Reading/Writing, Kinesthetic (VARK) questionnaire (Fleming and Mills, 2001) provided a profile of the participant’s preferred learning preference.

Computer Attitudes- The Computer Attitudes Questionnaire is designed to measure attitudes (feelings toward a person or thing) and prevailing attitudes (dispositions), rather than achievement (Knezek & Christensen, 1996).

Inquiry Task Performance- The final project consisted of a video produced by the participant that illustrated and explained their understanding of scientific procedures, conceptual understanding of intercellular infrastructure, and scientific communication techniques.

Conceptual Understanding- The Biology Conceptual Understanding Posttest contained 50-item multiple choice/true-false items subsequently referred to as *Biology post-test*. 
### Table 1. List of Variables, Instruments and Sources

<table>
<thead>
<tr>
<th>Variable</th>
<th>Scoring</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior Knowledge (Pre-test)</td>
<td>55 Questions</td>
<td>Multiple-choice focusing on the cell structure and intercellular movement. Administered individually on paper and pencil.</td>
</tr>
<tr>
<td>(Johnson &amp; Lawson, 1998)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Learning Preferences (Visual, Auditory, Reading/Writing and Kinesthetic)</td>
<td>13 Questions</td>
<td>Questionnaire that provides a profile of the participants preferred learning preference. Administered individually.</td>
</tr>
<tr>
<td>(Fleming &amp; Mills, 1992)</td>
<td>V= (1-12) A= (1-12) R= (1-12) K= (1-12)</td>
<td></td>
</tr>
<tr>
<td>Attitudes toward Computers (Modified)</td>
<td>16 Questions</td>
<td>The CAQ is designed to measure attitudes (feelings toward a person, or thing and prevailing attitudes (dispositions), rather than achievement. Administered individually.</td>
</tr>
<tr>
<td>(Knezek &amp; Christensen, 1996)</td>
<td>1=Strongly disagree 2=Disagree 3=Agree 4=Strongly Agree</td>
<td></td>
</tr>
<tr>
<td>Inquiry Task Performance (ER Final Project)</td>
<td>ER Project Rubric</td>
<td>Self-designed instrument measuring factual information, conceptual understanding, and scientific application. Project performed collaboratively.</td>
</tr>
<tr>
<td>Conceptual Understanding (Post-Test)</td>
<td>55 Questions</td>
<td>Multiple-choice focusing on cell structure and intercellular movement. Administered individually on Webct.</td>
</tr>
<tr>
<td>(Johnson &amp; Lawson, 1998)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Limitations of Study

Several factors may limit the findings in this study. Among these are (1) the lack of a comparison group, (2) varying degree of collaboration among participants in the ER Project, and (3) the nature of the VARK instrument as a measurement of learning preference.

(1) Lack of a comparison group: Both ER Project and Image-J technologies were innovations used by one professor in one biological imaging class. The content, specifically, made it highly unlikely that another professor in a similar class would have
offered the same content the same semester this class was offered. A control group was therefore not available for this study. As the study was designed to explore the interactions among all variables and the outcomes, I chose to limit this study to the natural implementation of the “intervention” in a class setting.

(2) The collaboration among student in groups could limit the measurement of their understanding and *ER Project* module use. All of the instruments were administered individually, while the *ER Project* was performed as a group of two. This collaboration can affect the individual scoring of the student’s inquiry performance task.

(3) Even though the VARK has been used in various research projects, the structure of the instrument can be limiting. The overall “preference” is assigned as a result of the individual’s scores on each of the four categories. This limitation was addressed in this study by assigning values to each category. Individual participants, therefore, did not have an overall VARK distinction, which usually includes one to four categories, based on the participant’s individual scores. Instead, participants had a score for each individual VARK distinction (i.e., Visual, Auditory, Read/Write, and Kinesthetic).

(4) Differences in pre- and post-test administration could have an effect on the correlation between the tests. The pre-test was administrated as a paper and pencil assessment individually during laboratory while the posttest was administrated individually on WebCT.
Summary Statement of Chapter I

The reform of science education has called for more innovative methods to introduce concepts to students with the constraints of undergraduate and K-12 learning environments. The aim of this study is to evaluate student variables that predict the effectiveness of using cellular data sets and *Image J* analysis software in an inquiry-learning environment. Prior knowledge, learning preferences, attitudes toward computers were identified as variables that may play a mediating role in individual learners' abilities to be successful in an inquiry rich, technology-mediated learning environment.
CHAPTER II

LITERATURE REVIEW

Generativity, or the ability to build on the scholarship and research of others, is one of the four hallmarks of scholarship (Schulman, 1999). With the other three – discipline, publication, and peer review – “generativity grants our work integrity and sophistication” (Boote & Beile, 2005). A comprehensive review of the literature can inform plans for the research, implementation of method, and basis for the formulation of arguments and their supports.

Boote & Beile (2005) suggested that the literature review is the “foundation of any research project” (p. 4) and list the objectives that the literature review should accomplish. The first is to seek widely to review literature in a number of areas in order to establish the broad context of the study, clearly demarcating what is and what is not within the scope of the investigation. The review should also establish there are indeed things left to be learned in the proposed field of inquiry, thus building a case that a hole in the literature does exist. Finally, the literature review should yield a new perspective in the synthesis of the literature and meet such standards as consistency, parsimony, elegance and fruitfulness – the same qualities characterizing good theory.

Conceptual Framework

I derived three basic understandings from the review of literature pertaining to the design of my research on the effectiveness of an instructional prototype in enhancing undergraduate students’ understanding of contemporary scientific ideas about the dynamic nature of the cell. These understandings were used to develop the Rationale, to
understand research regarding the Core Design Elements of the instructional tool, and to select Mediating Student Variables, which may impinge on the success of the instructional tool in students’ new understandings about the cell. These big ideas emerged from my review of the literature review:

1. New instructional models are needed to create synergy between scientific research and education to enhance learners’ conceptual understanding of the complexity of living systems (Rationale).

2. Resulting student outcomes of deep conceptual understanding can be achieved through inquiry learning with technology (Core Design Elements).

3. Student outcomes of inquiry learning with technology are often mediated by students’ individual differences, which include prior knowledge, learning preferences, and attitudes toward computers of the subject (Mediating Student Variables).

A concept map appearing in Figure 1 integrates these three ideas into the conceptual frame used to organize the sections of the literature review that follow. In these sections, I describe the particular features of the literature that led me to understand the broader implications of research investigating the use of instructional modules like the ER Project for solving dilemmas in undergraduate biology education (Rationale); I provide an overview of the research on inquiry and inquiry with technology that provides support for the core design elements of ER Project and the use of Image J as a visualization technology tool to be used within a context of student inquiry (Core Design Elements); and, I provide research results from the literature that hopefully will present
New instructional models are needed to promote

Synergy between scientific research and education

Ways to experience complexity in living systems

which will lead to

Deep conceptual understanding about cells and how science is done

can be achieved by

Inquiry learning

Innovative technology applications

can be incorporated into

can be mediated by

Student differences

include

Computer attitudes

Learning preferences

Prior knowledge

Figure 1. Conceptual Model for Organizing the Literature Review.

convincing arguments supporting my decisions to examine the interactions of three individual difference variables (prior knowledge, learning preference, and computer anxiety and motivation) with the ER Project, variables that may impinge upon students’
abilities to interact successfully with the technology-mediated inquiry environment
known as ER Project (Mediating Student Variables).

Finally, in conclusion and on the basis of the literature reviewed, I present the
foundations for a hypothetical path model suggesting relationships between and among a
number of variables to be examined statistically through path analysis.

**Rationale**

Current documents detailing the goals of science instruction (e.g., American
Association for the Advancement of Science, 1990; National Research Council, 1996)
have encouraged the creation of new instructional models and products that “promote a
synergy between scientific research and the education community” (Edelson et al., 1999,
p. 392). This form of synergy can be found in the ER Project developed for
undergraduate and K-12 students. This instructional prototype aims to create such a
synergy in undergraduate students’ understanding about the nature of cellular structure,
intercellular motion, and scientific processes. The instructional prototype was developed
to address two significant challenges for an undergraduate biology instructor: (1) to
convey the contemporary conceptual understanding of the cell as a three-dimensional,
dynamic system of multiple interacting components that constantly perform all of the
functions of the living organism; and (2) to create an environment for learning that
reflects discovery through scientific research.

*Complexity in Living Systems*

A common goal of standard freshman biology survey courses is to provide
students with the basic conceptual knowledge needed to enroll in advanced coursework
in a variety of areas such as genetics, ecology, and cell biology (Johnson & Lawson, 1998, p. 89). Unfortunately, biology students’ conceptual knowledge about the cell is often inadequate for future coursework. Students’ experiences with eukaryotic and prokaryotic cells are often limited to the professor’s lecture images (often two-dimensional micrographs and diagrams emphasizing structural features of the cell) and textbook descriptions. Experiences in the laboratory, if present at all, are commonly limited to the observation of recently killed or preserved cells with traditional light microscopes or two-dimensional images (Hansen, Barnett, Makinster & Keating, 2004). The traditional ways to present information about the dynamic nature of the cell have contributed little to undergraduate student’s development of modern conceptual understandings of the structure, function, and intercellular movements that occur constantly within the living cell. A more holistic, functional view of cellular structure has almost been impossible because of the limitations of available technology.

New scientific knowledge generated from the use of new visualization and analytical technologies has enabled scientists to observe cellular processes as they occur, as compared to previous technologies that could only reveal static cellular structures. New technologies have revealed new structural interactions within the cell, requiring an associated new complexity of understanding regarding structural, functional, and biochemical relationships among cellular components. The increase in complexity is a challenge to traditional instruction, which cannot sufficiently present the volume and complexity of information in a timely manner (Bockholt, West, Bollenbacher, 2003; Howard & Miskowski, 2005; National Research Council, 2003; Sawyer, 2006).
Instruction presented with technology, however, has the capacity to impact the students’ abilities to understand the complexity of cellular interactions. The “co-evolution of information and technology with teaching and learning methods” can influence instruction (Bockholt et al., 2003). The manipulation and combination of information with technology into modules of instruction allows students to experience technology-supported, inquiry-based instruction, experiments and interactive learning that would otherwise not be possible due to the complexity of topics, as well as laboratory hazards, costs, and/or ethical dilemmas (Bockholt et al., 2003).

**Synergy between Scientific Research and the Education Community**

Synergy between scientific research and education occurs when learning tasks require students to use the processes, skills, and habits of mind necessary for experts to do science. The development of learners to emulate or comprehend the transition of novice to expert skills as research scientists requires careful instructional scaffolding and curriculum manipulation (Duschl, Schweingruber & Shouse, 2007). The use of inquiry instruction with an authentic pursuit of new understanding presents students with a learning environment similar to the research environment of scientists. This type of learning environment increases the novice learner’s understanding of how scientists do science while also requiring them to think like scientists. By working as scientists novice learners can get a clearer view of more expert scientific practices (Blumenfeld, Kempler, & Krajcik, 2006).

To understand how scientists think and act, instructional designers must understand what makes scientists experts in their field. Experts are able to use a range of
signs and symbols to create an understanding of scientific phenomena. They move with “fluidity back and forth between representations and use them together to solve problems. Furthermore, these representations are used within a community of other scientists to state hypotheses, make claims, draw inferences, ask questions, raise objections, reach conclusions” (Bransford et al., 2000). These characteristics may seem simple everyday skills to experts but to most novice learners they can be challenging. Learners’ understanding is often constrained by the physical aspects of a scientific phenomenon and there is frequently little about these surface features that correspond to underlying entities or processes. Novices’ understanding also seems to be constrained by the surface features of symbol systems and symbolic expressions used to represent science. In some instances, college students can hold a variety of misconceptions about chemical equilibrium corresponding to the symbol systems that they used in learning about the concept (Kozma, 2000).

Understanding potential synergies between contexts in their relationship towards a pathway to expertise suggests more developmental studies for instructional developers. An understanding of the challenges faced by novices gives instructional developers a baseline at which to develop their tools to enhance instruction and curriculum development. Investigations involving the challenges faced by novices can also provide an understanding of the learners’ correspondence to qualities of routine expertise or adaptive expertise (Donovan and Bransford, 2005; Quintana, Shin, Norris & Soloway, 2006). Research on the types of expertise resulting from interventions involving problem-solving scenarios has revealed that routine experts, while expert in the
processes and routines of their work, are not as capable in solving problems that require
unique, creative solutions. The call still exists for innovative curricula that enhance
students’ abilities to approach problems adaptively to encourage this important
characteristic of problem-solvers working in a complex, constantly changing world.

*Deep Conceptual Understandings about Significant Scientific Ideas*

The need for deeper conceptual understandings about the world in which we live
corresponds to the current societal shift from an industrialized-based to a knowledge-
based economy. Previously, learners could memorize and successfully navigate through
education and society. Producing the correct answer does not necessarily mean that the
student understands the underlying concepts. Horowitz and Christie (2000) found that it
was all too common for science teachers to find that students who received good grades
were unable to apply basic principles shortly after the completion of a course. In the fast-
paced world of today, however, current learners need to creatively process and manage
information in order to learn, live, and work as productive members of society
(American Association for the Advancement of Science, 1993). Learners in today’s
society need to “learn integrated and usable knowledge rather than the sets of
compartmentalized and decontextualized facts emphasized by instructionism” (Sawyer,
the redesign of learning environments that emphasized students’ development of deep
understandings about the world, rather than their development of memorized, inert
information.
Dorothy Gabel (2003), a renowned science educator, discussed a number of effective instructional strategies for developing conceptual understandings about scientific phenomena. Gabel explains that teaching science for conceptual understanding is a complex issue, involving learning the macroscopic properties of phenomena and processes using models, using symbols in mathematical problem solving, and understanding the processes that scientists use in inquiry (Gabel, 2003). Kozma (2000) and others related active involvement to the development of deep conceptual understanding, in a way that allows learners to use the knowledge they already have as a basis for developing new insights (e.g., Bransford et al., 2000; Chinn & Malhotra, 2002; Gabel, 2003).

Gabel (2003) also described the interdependence between and among the development of learners’ conceptual understanding, their prior knowledge, and the complexity and quantity of concepts to be learned. She suggested that teachers and policies follow the blueprint of the National Science Education Standards to regulate the effectiveness of instruction, saying that oversaturating students with concepts will cause them to memorize, which is detrimental to learning (Gabel, 2003, Novak, 2002). Furthermore, Songer (2006) provided empirical evidence that longer interventions were essential for students to develop deeper conceptual understandings of physical science concepts.

Some of the common methods reviewed by Gabel (2003) for enhancing the development of conceptual understanding included “implementing a learning cycle approach to instruction, adopting a science/technology/society approach, embedding
science learning in real-life situations, using discrepant events, using analogies, integrating collaborative learning, employing wait-time, applying concept mapping, using mathematical problem solving, and inquiry”.

Lawson (2001) described three types of learning cycles: “descriptive, empirical adductive, and hypothetical-predictive” (p.166). The learning cycle is an instructional model composed of three parts: exploration, invention, and application and has evolved into engage, explore, explain, extend and evaluate. Its application has been the framework for producing increased conceptual understanding, improved critical thinking skills, and more positive attitudes toward science (Abraham & Renner, 1989; Dogru-Atay & Tekkaya, 2008; Gabel, 2003, Singer & Moscovici, 2008)

Another method for developing the learner’s conceptual understanding is the use of analogies. Lawson (2001) mentioned that analogies play a role in the theoretical concept construction. This construct is achieved by learners’ assembling “patterns from the world of familiar objects and events and borrowing it to explain unfamiliar objects and events” (p.168). They also provided a medium to motivate and eliminate misconception (Megan & Orgill, 2007). The use of collaborative learning causes learners to rely on social interaction for improving problem solving and social development and has been shown to increase achievement scores and conceptual understanding. One very common method to analysis learner’s conceptual understanding is wait-time, a simple but effective questioning method that causes students to reflect on their answers (Rowe, 1974). Another method for evaluating conceptual understanding is through the use of mathematical problem solving, requiring
using a collection of mathematical steps to solve a problem. This method is self-evident in the development of understanding.

Finally, Gabel (2003) discusses the use of inquiry, defined as an instructional framework that engages students through scientifically oriented questions. While they obtain evidence to the related question, formulate explanations from the evidence, evaluate the explanations in light of the possible explanation; and communicate and justify their explanations to others. Of all of the strategies listed by Gabel, the research on inquiry presented the best argument for its use in designing instruction. Edelson (2001) and others have consistently supported inquiry activities as well, stating that the engagement of learners in inquiry activities can enhance conceptual understanding through the processes of discovery and refinement.

Conceptual understanding can also be enhanced by scaffolding (White & Frederikesen, 2000; Lee & Songer, 2003). Effective learning environments scaffold student’s active construction of knowledge in ways similar to the way that scaffolding supports the construction of a building (Sawyer, 2006, p. 11). Scaffolding can be provided in the learning environment in many ways. Trinidade, Fiolhars & Almeida (2002) showed that the use of a three-dimensional computer-animation increased conceptual understanding of some concepts in students with high spatial abilities. The main strength of this research was the use of visualization as a scaffold to immerse the learner in a situation otherwise inconceivable. Wu et al.’s (2001) research showed that learners with high engagement had a high conceptual understanding in a learning environment in which there was underlying collaboration and discussion of the concepts.
Findings in a study by White and Frederiksen (2000) the researchers demonstrated that various kinds of scaffolding mechanisms improved student’s conceptual understanding. Use of climatology and visualization technology by Edelson et al. (2006) led to the development of skills such as formulating and refining researchable questions, planning and conducting, investigation, and reporting results.

An empirical study by Keller, Finkelstein, Perkins, and Pollock (2007) was designed to observe the effects of computer simulation environments in a calculus-based introductory physics course on the conceptual understanding of 360 students. The first part of the study concluded that there was a significant improvement in concept performance in lecture when students observed the simulation compared to working with the physical equipment. They also observed no difference in examination performance in an inquiry-based laboratory, but had a positive outcome when groups were asked whether they favored the simulation over the real equipment.

Researchers Trindade et al. (2002) wanted to know if the conceptual understanding acquired with three-dimensional virtual reality varied with students’ spatial aptitude. They concluded that the viewing of three-dimensional computer animations produced an increase in conceptual understanding of some of the content in students with higher spatial abilities. Interaction, navigation, and three-dimensional perception were the most influential visualization parameters. These researchers recommended that future research include the transferability of the understood concepts.

Zacharia (2007) investigated the value of combining real experimentation with virtual experimentation with respect to changes in students’ conceptual understanding of
electric current. The researchers performed a pre-post comparison study of 90 students in an introductory physic course. The control group experienced the traditional laboratory experiment while the experimental group used both the virtual experiment and the traditionally used laboratory experiment. Results showed that the combination of the two forms of instruction enhanced the students’ conceptual understanding more than the traditional experiment.

Core Design Elements

Inquiry Learning

Contemporary foundations of science teaching and learning reverberate with science standards requiring the development of students’ abilities to reason scientifically (e.g., American Association for the Advancement of Science, 1990, 1993; Kuhn, 1996; National Research Council, 2003). The books Science for All Americans (1990), Benchmarks for Science Literacy (1993), and National Science Education Standards (1996) have provided blueprints for research, reform, and the development of teacher and students. Scientific literacy includes abilities to engage in several kinds of complex reasoning, including being able to distinguish salient from irrelevant information, explaining and predicting scientific events, reading with understanding, evaluating and applying evidence and arguments appropriately (NRC, 1996; Songer, 2006). Inquiry learning has been intertwined with students’ development of scientific concepts, understanding about science as a way of knowing about the world, and abilities to apply scientific information to new contexts. Authors of science education standards agree that instruction should incorporate methods of producing questions and methodologically
answering them, with the intent of strengthening students’ skills of argumentation, reflection, and reevaluation. Duschl, Schweingruber, and Shouse (2007) recently identified four strands of scientific proficiency that are directly linked to inquiry learning, which are neither “independent nor separable in the practice of science, nor in the teaching and learning of science” (p. 36).

The strands of scientific proficiency lay out broad learning goals for students. They address the knowledge and reasoning skills that students must eventually acquire to be considered fully proficient in science. They are also a means to that end: they are practices that students need to participate in and become fluent with in order to develop proficiency. Students who are proficient in science: (1) know, use, and interpret scientific explanations of the natural world; (2) generate and evaluate scientific evidence and explanations; (3) understand the nature and development of scientific knowledge; and (4) participate productively in scientific practices and discourse. (Duschl et al., 2007, p. 36).

Duschel et al.’s identification of these four proficiencies has a history in the recent literature. Nature of Science (American Association for the Advancement of Science, 1990) discussed requisites for scientific literacy: scientific method of inquiry, and the nature of the scientific enterprise. As learners develop in scientific comprehension and literacy they must also understand the basic beliefs and attitudes scientist share, which in turn illustrates the scientists’ own engagement with worldly phenomena. The engagement of learners in scientific inquiry places them in situations
were they can replicate scientist views that science requires evidence, logic and imagination, while trying to explain and predict new phenomena.

As learners mature in their understanding of science they will also grow in their understanding that science is ever changing and that it advances with the development of new technologies, that science builds upon knowledge generated from past research, and that there is dependability to scientific information because of the ways that scientific information is produced. Regarding the latter, the authors of the *Nature of Science* warn that learners must not take the dependability of science for granted, due to the potential of researcher bias and existence of phenomena that are immeasurable; that science is not the be all to end all, but a method for analyzing what is and what may be.

Authors of the *National Science Education Standards* (National Research Council, 1996) discuss the benefits to students of participating in the processes of scientific analysis in an inquiry environment. They stress that learners must be able to understand and do inquiry investigations and that participation in the processes of science through inquiry learning enhances student development. They also stress that students must be engaged in the authentic practices of scientific inquiry, which include the construction of explanations and preparation of arguments to communicate and justify these explanations.

While previous standards have been directed toward K-12 education, *Biol2010: The Transforming Undergraduate Education for Future Research Biologists* (NRC, 2003) was charged with examining the formal undergraduate education, training, and experience required to prepare the next generation of life science majors with a
particular emphasis on the preparation of students for careers in biomedical research. These authors also wanted to produce an innovative and realizable national plan for modifying undergraduate biology education so that life science majors could begin their research careers better prepared for the challenges and opportunities of the next decade and beyond. This undergraduate reform document acknowledged the framework for making decisions about the design of learning environments discussed in How People Learn (HPL). The HPL framework, as noted by Bransford, Brown, & Cocking, (2000), outlined reformed teaching from research generated from the learning sciences perspective, synthesized to reflect four lenses for decision making in terms of learning environment design. These are the knowledge-centered, learner-center, assessment-centered, and community-centered lenses. In addition, the authors also stressed the need to share the excitement of biology with students by replicating the idea of independent work within the context of courses by incorporating inquiry–based learning project labs, and group assignments (Bransford et al., 2000; MacNabb, Schmitt, Michlin, Harris, Thomas, Chittendon, Ebner et al., 2006).

Bransford et al. (2000) describes the knowledge-centered lens as the lens used by the instructional designer on the basis of deciding what we want our learners to know and be able to do as a result of instruction; the learner-centered lens is used to examine the extent to which a learning environment builds on the strengths, interest, and preconceptions of the learners; the assessment centered lens is used to examine the extent to which students’ thinking is made visible within the learning environment, so that teachers can adjust instruction to their students’ reasoning, whereby students would
have multiple opportunities to share, test and revise their ideas; and finally, the
community-centered lens is used to examine the extent to which the classroom is an
environment in which students not only feel safe in asking questions but also can learn to
work collaboratively.

As mentioned earlier, this framework has been used extensively in current reform
(National Research Council, 2003) and curriculum development (Cobb & McClain,
2006, Edelson, Gordin & Pea, 1999). The HPL framework has also been perceived to be
consistent with authentic inquiry learning environments, which design to enhance
students’ understanding of scientific concepts, processes and reasoning – the essential
skills for reasoning about phenomena in the natural world.

One of the central theories of the learning sciences is the strong recommendation
that students be given opportunities to engage in meaningful scientific inquiry-tasks,
posing scientific questions, designing experiments to collect evidence, and making
critical interpretations of observations (Donovan and Bransford, 2005; National
Research Council (2003). Science as inquiry reinforces the notion that science should be
learned in the way that science is done, which extends through formal education during
college and university years (Siebert and McIntosh, 2001).

In the evolution of inquiry, researchers attempt to design inquiry situations as
authentic to actual scientific research as possible. Bonstetter (1998) described an
approach where the advancement of student inquiry causes a transformation in the
learner. He recommended projects for the learners that move from more teacher-
directed, hands-on inquiry to student-guided inquiry.
The development of an inquiry learning environment contains five necessary components: (1) learner engages in scientifically oriented questions, (2) learner gives priority to evidence in responding to questions, (3) learner formulates explanations from evidence, (4) learner connects explanations to scientific knowledge and (5) learner communicates and justifies explanation (NRC, 1996, p. 25). Engaging students in authentic practices raises a number of pedagogical challenges for designers of learning experiences. Critical pedagogical challenges included “(1) helping students deal with the complexity of authentic practices, and (2) helping them to understand the rationale for the elements of these practices” (Edelson et al., 2006, p. 336).

Howard and Miskowski’s (2005) empirical research had three positive outcomes with inquiry modules: (1) students scored higher on the last module compared to the first module, (2) students performed well on a national major field test, scoring higher in the cell biology subsection, and (3) researchers on the survey tool observed improvement in students’ ability to make connections between concepts in analysis, and in their defense of data.

The transformation of simple inquiry into authentic scientific inquiry provides opportunities for students to evolve into capable and responsible learners (Lee & Songer, 2003). Various measures can be taken to add authenticity to science tasks:

1. Authenticity is addressed by using real-world problems faced by scientists (Lee & Songer, 2003; Edelson et al., 1999).

2. Authenticity is obtained through students’ solution of problems from their own lives. Problems are pursued in student’s own interests (Lee & Songer, 2003; Krajick et al., 1998).
3. Authenticity is obtained by linking students and scientists through data sharing, critiquing and direct communication (Lee & Songer, 2003).

4. Authenticity is added when science tasks address what scientists do to reach common understandings, including arguments (Lee & Songer, 2003, p. 927).

Authentic inquiry can contribute to the development of science content understanding through problematic situations, demand for knowledge or ownership, discovery/refinement and application of content (Edelson, 2001). Songer (2006) mentioned in conjunction with other researchers that learning is affected not necessarily by a given written curriculum, but by the way these resources are used by a particular target audience and toward particular learning goal.

In the context of the explosive growth of scientific information, current research has shown that authentic inquiry situations in the classroom can be used in “popularizing basic concepts of structure-function relationships of living cells, introducing people to the scientific method, stimulating inquiry, and reviewing general concepts and paradigms” (Araujo-Jorge, Cardona, Mendes, Henriques-Pons, Meirelles & Coutinho, 2004, p. 100).

Bednarski, Elgin, and Pakrasi (2005) developed an inquiry-based module introducing bioinformatics concepts and techniques to undergraduates. The presentation of this information in an inquiry format caused the students to exhibit a sufficient understanding of bioinformatics, and a significant number of learners showed increases in their understanding of concepts and in their abilities to apply bioinformatics database techniques. In addition to the Bednarski et al. (2005) project, Howard and Miskowski
(2005) used an authentic inquiry situation to develop students’ critical thinking skills in reference to cell biology, and more specifically cell functions. Students in this study showed a 79 percent improvement in critical thinking. Both projects presented a positive influence on learners’ retention of cellular concepts, which influenced a percentage of the learners overall. Unfortunately, there were a percentage of learners who were unable to process the information and achieve benefits associated with the use of inquiry. This inability to engage in an inquiry learning environment is one area of attention which will be addressed by this research.

Innovative Technology Application

Two works were particularly useful in informing the design of this study. Edelson, Gordon and Pea (1999) addressed the challenges of inquiry-based learning through technology and curriculum design. The authors discussed some of the barriers students and teachers encounter as they use technology-supported inquiry learning. Chinn and Malhotra (2002) *Epistemologically Authentic Inquiry in Schools: a Theoretical Framework for Evaluating Inquiry Tasks* provided a systemic method to qualitatively and quantitatively evaluate inquiry teaching and learning. These two articles provided a basis for evaluating the barriers, which might influence the engagement and comprehension of learners in authentic scientific inquiry situation supported by technology.

The use of authentic inquiry learning with technology unveils barriers/challenges learners might encounter while working toward understanding a scientific concept or process. Some of the common barriers (Edelson et al., 1999) included motivation,
accessibility to investigation techniques, background knowledge, management of extended activities, and practical constraints of the learning context. The implementation of authentic inquiry learning has been shown to reduce the effects of these barriers, while developing basic inquiry abilities, specific investigation skills, and understanding of scientific concepts and principles (Edelson et al., 1999).

Researchers have minimized these barriers/challenges by presenting either more meaningful problems or creating staging activities, bridging activities, supportive-user interfaces, embedded information sources, and record-keeping tools (Edelson et al., 1999). The introduction of meaningful problems provides the students with a sense of ownership to their learning. This ownership has been seen to motivate students and influence the standard of work presented by learners (Bransford et al., 2000; Donovan & Bransford, 2005; Edelson et al., 1999). Staging activities motivate and develop background knowledge through investigative techniques presented in inquiry situations. Bridging activities close the gap between the known practices of the scientist and learned techniques of students. The supportive user interface provides scaffolding for learners by embedding the tacit knowledge of an expert in the user-interface. An embedded information source supplies information about a particular investigation tool or needed background knowledge. Finally, record keeping tools allow learners to record and process information in inquiry activities (Edelson et al., 1999).

Edelson et al. (1999) also observed that the manipulation of the inquiry structure could counteract some of the challenges/barriers encountered. Chinn and Malhotra (2001) analyzed inquiry tasks in relation to authenticity and developed a systemic
method of evaluating the production of authentic inquiry instruction. Some of the tasks providing authenticity in scientific inquiry included hand-ons tasks, computer-simulated experimentation, database tasks, evidence evaluation tasks, and verbal design studies. These authors suggested that a combination of these tasks could have a greater contribution to the authenticity of an inquiry project.

The *Climate Visualizer* adapted scientists’ tools for learner use (Gordin, Polman, & Pea, 1994). This adaptation required that the complexity of the tools be reduced so that students would have accessibility to a tool similar to the one scientists used in their research. The aim of the project was to present an entirely student-driven inquiry learning experience where the students generated and pursued their own research questions. Research with the *Climate Visualizer* revealed that teaching students to manage open-ended questioning was a challenge and that classroom constraints and motivation persisted as problems.

*The Greenhouse Effect Visualizer* (Edelson et al., 1999) was designed to address motivation, accessibility, background knowledge, and practical classroom constraints. Motivation was addressed by presenting social and political issues. Background knowledge was addressed by through additional documentation and scientific explanation incorporated in the web-based interface. Background knowledge persisted as a challenge in that students had difficulty understanding abstract variables and units of measurement. Classroom constraints associated with reliability of the Internet, were also evident.
World Watcher (Edelson et al., 1999) was an application designed to evaluate global climate change. The project addressed background knowledge, both in technology and curriculum design. This application provided extensive explanatory materials for the data sets and incorporated activities in the curriculum to help develop the scientific knowledge of the learner. Quantitative activities provided guided examples and annotated visualizations that were created through mathematical operations to address the unguided nature of the investigations.

Horwitz and Christie (2000) developed an inquiry environment called GenScope to help beginning biology students understand the relation between genotype and phenotype, among other pedagogical goals. These designers found that students were able to understand the underlying scientific relation between genetic processes at the cellular level and physical characteristics at an organism level.

The application developed by Kozma (2000), 4m:chem, provided a symbolic pallet that could be used to support students’ thinking and argumentation. Record-keeping tools provided students with the opportunity to create and monitor plans, articulate hypothesis, analyze evidence carefully and reflect on their progress. This researcher concluded that the symbolic pallet was best used in a rich social context to prompted students to interact with each other and with multiple symbol systems to create meaning for scientific phenomena. Kozma also suggested continued research on this type of technology-rich environment on the cognitive and social practices of science learning.
White and Frederiksen (2000) designed *ThinkerTools*, in which students operate on symbolic elements to develop a Newtonian understanding of the relation between force and motion. By interacting with the symbol system the students acquired an understanding of the relation between force and acceleration as it is traditionally represented in a force–acceleration equation and as it mimics real-world action.

The use of an authentic inquiry learning environment provided a platform for students to comprehend concepts and evolve into responsible learners, challenging students to adapt to the open-ended environment where students themselves understand the target phenomenon in sufficient details to pose their own questions and devise methods for answering them. This type of learning environment required the instructional designer (that is, the teacher) to carefully examine instructional methods that foster, or scaffold, the progressive development of scientific explanations, data analysis, and hypothesis generation in novice learners (Bonnstetter, 2000; Songer, 2006).

These skills are essential for developing scientific literacy in our learners – to develop effective scaffolds for students to learn and understand important *big ideas of science* (Duschl et al., 2007); to engage in complex reasoning, including the ability to distinguish salient from irrelevant information; to explain and predict scientific events; and to evaluate and apply evidence and arguments appropriately (NRC, 1996; Songer, 2006). Scaffolds included (a) making science accessible, (b) making thinking visible, (c) helping students learn from others, and (d) promoting autonomy and lifelong learning (Quintana et al., 2006).
Mediatory Student Variables

Research findings indicate strong support for inquiry-rich, technology-enhanced learning environments in enhancing students’ conceptual understanding. However, research results also indicated that there are individual differences among learners that may mediate the effects of an innovative treatment on student learning. The question for me in reviewing the literature on individual differences was to identify individual difference variables that were likely to cause an effect on learning in the Image J learning environment. What student variables would be likely to mediate their interactions with Image J as an instructional intervention and mediate biology students’ overall conceptual understanding of the dynamic nature of cells? In a statistical sense, mediating variables are defined as variables that describe how (rather than when) effects will occur by accounting for the relationship between an independent and a dependent variable. In the case of my investigation of the relationship between the Image J intervention and conceptual understanding, I was interested in identifying potential mediating variables that would impinge upon students’ abilities to interact conceptually, emotionally, or physically with the ER Project intervention.

Student Differences

From my review of the literature, I identified three individual difference variables most likely to play a mediating role in students’ abilities to interact with the ER Project intervention and subsequent conceptual understanding of the cell: (1) prior knowledge, (2) learning preference, and (3) attitudes towards computers. Although learning preference remains a controversial construct in the educational psychology
literature, the construct continues to appear in many studies as a variable that mediates the effects of innovative strategies on student learning (e.g., Kolb, 1984; Tanner & Allen, 2004).

In the light of the particular importance of visualization as a strategy incorporated into the development of the ER Project, I chose to investigate the interactions of students’ learning preferences, particularly as they relate to their preferences for learning visually, and their learning about the cell. The role of prior knowledge, however, is not controversial. The learning sciences community consistently has identified prior knowledge as playing a central and very significant role in students’ abilities to learn new information as well as interact in inquiry-based learning environments (Bransford et al., 1999; Donovan et al., 2005).

Finally, students’ attitudes towards computers was also identified as a potential mediating variable affecting students’ abilities to interaction in the ER Project learning environment in which students were required to interact with computers to learn new information. While advantages are obvious to the use of computers in modeling complex natural phenomena, students’ receptivity to computers, measured on scales of computer anxiety, has been shown to be a mediating variable in the effects of computer-based learning environments on student learning. The following section reviews literature relating these three variables to the use of technology-mediated, inquiry-based science curricula: (1) prior knowledge, (2) learning preference, and (3) computer anxiety.
Prior Knowledge

A growing body of research supports the notion that misconceptions that students bring to a learning environment interfere with the acquisition of new knowledge. Researchers have found that specific teaching techniques can be used to change those misconceptions (Siebert & McIntosh, 2001). Learning “requires that people restructure their thinking radically, this involves the connection among things they already know, or even discard some long-held beliefs about the world. If their misconceptions are ignored or dismissed, their original beliefs might persist” (Science for All Americans, American Association for the Advancement of Science, 1990). The persistence of unaddressed prior knowledge deficiencies leaves flaws in students’ learning. “Students’ enter the classroom as empty vessels, waiting to be filled; they enter the classroom with half formed ideas and misconceptions about how the world works-sometimes called ‘naïve’ physics, math, and biology” (Sawyer, 2006, p. 11).

Donovan and Bransford (2005) theoretically identified a major instructional challenge: to support students in building and bridging prior knowledge to new scientific concept experiences. When prior knowledge and scientific processes are emphasized, the “understandings that grow out of a creative process of observation, imagining, and reasoning make a connections with what one already knows” (p.523). Research has shown that activities incorporating reflection allow learners to build on their prior knowledge, to dismantle prior misconceptions and to bridge the new learned phenomenon. The use of computer software can support learners’ views, create different kinds of content-based and knowledge-based representations of their thinking and make
connections between ideas in the representation (Siebert & McIntosh, 2001).

Prior knowledge can have both positive and negative effects on student transfer and retention of information. Johnson & Lawson (1998) found that prior knowledge was not a significant predictor of achievement in an empirical study aimed to identify factors that were effective predictors of success in college biology. These researchers used a pretest on content knowledge to determine students’ prior knowledge and abilities to reason. Furthermore, the researchers also evaluated students’ numbers of previous biology courses. The study showed that reasoning ability was a significant achievement predictor in inquiry situations; and that prior knowledge did not show significance in predicting achievement in either inquiry or expository instruction. In addition to their findings, Johnson and Lawson also referenced research by Anderson, Sheldon, and Dubay (1990) and McAdaragh (1981), which also did not exhibit significant differences between pre- and post-tests on scientific concepts.

Other researchers have found prior knowledge to have a positive effect on the learner. According to Edelson (2001), the design of staging and bridging activities (Edelson, 2001) enables one to address the challenge of background knowledge. Each of the staging activities in one of Edelson’s curriculum sequences was designed to help students develop and refine their understanding of specific content. Sequenced appropriately, staging activities built on each other in successive steps helped students develop the knowledge and skills that enabled them to engage in open-ended investigations (Edelson et al., 1999).
Once engaged in inquiry, students often require additional knowledge to complete their investigations and interpret their results. In successfully addressing the challenge of background knowledge, an instructional design can meet this need by supporting the further development of content understanding. Edelson (2001) identified the tacit knowledge upon which scientists draw to create and interpret visualizations; they embedded that knowledge in the form of contextual information in the user interface. “We provided additional scaffolds in the form of default settings that enabled learners to create interpretable visualizations without requiring any foreknowledge of the data” (p.444). Edelson found that successful use of Climate Visualizer and Radiation Budget Visualizer required a particular level of background knowledge to support the classroom constraints presented on the classroom setting (Edelson et al., 1999). The lack of background knowledge lowered students’ adaptabilities in working with open-ended questions. These researchers made the point that instructors need to recognize that students construct knowledge based on previous understanding and experience. This theory of learning is valid constructivism, according to which students construct new understandings on an existing framework of knowledge (Lorsbach & Tobin, 1993; Siebert & McIntosh, 2001).

An empirical study by McComas and Moore (2001) was designed to investigate the role of prior knowledge on students’ abilities to observe scientific phenomenon in the laboratory. The researchers observed that prior knowledge could have an effect on how learners observe and analyze experiment. The expectancy effect is a challenge for science teachers because learners are using their prior knowledge brought into the
classroom or given to them prior to experiments to influence their analysis. Two forms of experimenter effects are biosocial and non-biosocial. Non-biosocial is of interest because it is related to the experimenters “prior knowledge and anticipating, what influence, what is observed, what is ignored as irrelevant, what data are called in question.” In this given experiment, the researchers gave students three bottles filled with *Daphnia* and spring water. They labeled the bottles (depressant, stimulus and unknown) and told students to evaluate the heartbeats of the *Daphnia*. Even though the contents of the bottles were the same, there were significant differences in evaluating the contents in relation to the labeling of the bottle. The learners were using their prior knowledge to influence their analysis. Prior knowledge in an inquiry setting is an important aspect of the nature of science and the observation of the scientific phenomena.

One of the outcomes of the Wu et al. (2001) study noted students with limited prior knowledge were able to achieve conceptual understanding of chemical bonds and structure with the assistance of the use of the *eChem* module, which caused them to transfer from novice to expert observations of patterns.

The *ER Project* contains scientific terms, concepts and techniques taught and used in current scientific research. An analysis of the learner’s prior knowledge builds a baseline for observing the learner’s cognitive interaction with the *ER Project* intervention. While some research does not appear to support the significance of prior knowledge in learning new concepts, most recent research identifies prior knowledge as an important factor in learning. Prior knowledge in the *ER Project* was evaluated by
assembling questions with which learners at the junior or senior undergraduate level should have some familiarity. The questions were used for pre-test post-test comparisons of students’ prior content knowledge. This method was used in several empirical studies mentioned previously that used inquiry instruction and observed prior knowledge influence with technology assistance.

Learning Preferences

Learning preference has been defined in many ways, including the complex manner and conditions under which, “learners most efficiently and most effectively perceive, process, store and recall what they are attempting to learn or alternatively the preferences or predisposition of a particular way or combination of ways” (Kolb, 1984; Tanner & Allen, 2004). We all learn through a variety of mechanisms and we learn more if the mode of instruction matches our learning preference (Kolb, 1984).

Learning preference theory suggests that individuals have different ways of learning, and when teaching accommodates these styles, learning is enhanced. Learning preferences can be based on different preferences in cognitive information processing (e.g., Kolb, 1984), personality or temperament (e.g., Keirsey, 1998), and social interaction (e.g., Grasha, 1996; Sonnenwald & Li, 2003).

Although there are many different models for learning preference, no single model can adequately describe the ways in which a particular individual prefers to learn. Tanner and Allen (2004) evaluated the Visual, Auditory, Read/Write, and Kinesthetic Inventory (VARK) (Fleming and Mills, 1992), Multiple Intelligences (Gardners, 1993) and Dimensions of Learning Preference in Science (Felder & Silverman, 1988). They
inferred from sampling various researchers that no one instrument is superior or inferior to the other (Tanner & Allen, 2004). The authors used a learning preference questionnaire as a catalyst to empower students to reflect on their own sensory preferences and modify their study methods accordingly. As previously stated, learners who reflect and take ownership of their work acquire deeper understanding of concepts.

Felder and Silverman (1988) studied different learning preferences to develop a scheme for determining the preferred learning and teaching styles. Their instrument consisted of five groups: (1) sensory/intuitive, (2) visual/verbal, (3) inductive/deductive, (4) active/reflective, and (5) sequential/global. They concluded that students learn better from processes that are sensory, visual, inductive and active, while lectures tend to be verbal, deductive and passive (Trindade, Fiolhais & Almeida (2002).

The empirical study by Jones, Reichard and Makhtar (2003) investigated the role of student learning style preferences using the Kolb Learning Style Inventory (1994), which is composed of four major groups: (1) accommodators, (2) divergers, (3) convergers and (4) assimilators. Results of their research revealed a difference in learning styles across disciplines, but astonishingly it also showed learners were able to adapt to different disciplines. While students may not consciously be aware of their learning preferences, an increase in their awareness of their learning presence can have a positive influence on their academic performance.

McAndrews, Mullen and Chadwick (2005) measured the relationships among learning preferences with a web-based program. The Computer Interactive Learning Multimedia Program for Learning Enhancement was designed to provide students with a
computer-based learning program to supplement their students’ laboratory experiences. The researchers questioned whether students’ preferences for specific learning styles would be benefitive or hindered by computer–based learning systems. The results of the study showed that computer-aided instruction can be designed to appeal to students across all learning styles with, however, differences in achievement attributed to differences in learning style. Furthermore, this research demonstrated a connection between the student’s motivation to use instructional technology and the frequency of using the technology, and it offers suggestions of ways to increase use motivation of technology to improve learning outcomes. This study, however, did not investigate effects on conceptual understanding.

Tanner and Allen (2004) pointed out visual resources are becoming increasingly available in the life sciences. Visual media are able to present learning in ways that are responsive to different learning preferences and to the most effective pedagogies of learning science. In addition, a learning module can provide students some exposure to the research process, especially in cases where scientific research opportunities are not unavailable due to limited resources and infrastructure (Bockholt et al., 2003). Inquiry environments can address multiple learning preferences which might be difficult for the instructor. Fleming and Mills (1992) stated it is simply not realistic to expect instructors to provide instruction that accommodates the learning style diversity present in a classroom. Instructional presentation that caters to all students is a daunting task, but technology-supported inquiry learning has the capability to empower a diversified group of learners in the scientific classroom. These developers of the VARK sought to
empower students through knowledge of their own learning styles to adjust their learning behavior to the learning programs they encountered (Flemings & Mills, 1992). The structure of the VARK is such that learners assess their own preferences for learning through their responses to a 13-item scale, which assesses the degree to which learners prefer to learn through visual, auditory, reading, or kinesthetic means. Students score high or low on each preference scale, resulting in a score for each scale. My reasoning was that students in the ER Project, who scored high on the visual scale indicating that they preferred to learn visually, would out-perform students with lower visual scores on their ER Project learning products.

**Attitudes toward Computers**

Since the late 1980's, cognitive scientists, educators, and technologists have suggested that deeper understanding of phenomena in the physical and social worlds could be easier for learners to comprehend if they could build and manipulate models of the phenomena (Bransford et al., 2000). Thus, the additions of technology in the forms of computers, databases, high-end equipment, websites, and other innovative tools, have been the source of many studies investigating their contributions to instructional and learning processes.

Blumenfeld et al. (1991) identified six contributions that technology can make to the learning process:

- Enhancing interest and motivation
- Providing access to information
- Allowing active, manipulability representations
- Structuring the process with tactical and strategic support.
- Diagnosing and correcting errors
• Managing complexity and aiding productions

Just as computers are used ubiquitously in contemporary scientific laboratories for performing daily research tasks, it is has become increasingly important to use computers in the science classroom for daily learning tasks. As stated in the National Research Council’s (NRC) *BIO2010* report:

Computer use is a fact of life for all scientists. Exposure during the early years of their undergraduate careers will help life science students use current computer methods and learn how to exploit emerging computer technologies as they arise…. Becoming fully conversant with databases such as the National Center for Biotechnology Information (NCBI) is important for all biology students. Computer use is a fact of life for all modern life scientists. Exposure during the early years of their undergraduate careers will help life science students use current computer methods and learn how to exploit emerging computer technologies as they rise…… (NRC, 2003, p. 27).

The use of computers and information technology gives students the ability to view science on “three different levels, each increasingly in complexity: the phenomenon (macroscopic), the particle (microscopic), and the symbolic” (Gabel, 2003). The incorporation of computer-based technology into biology teaching and research laboratories has made it increasingly more important for science students to be comfortable with computers as learning tools. The challenge for education is to design technologies for learning that draw both from knowledge about human cognition and
from practical applications of how technology can facilitate complex tasks in the workplace (Bransford et al., 2000).

In contrast, Quintana et al., (2006) identified two reasons that technology has been less than successful for supporting learning and achieving learning goals: (1) failure to understand how *technology must be shaped* to support the needs of the learner; and (2) failure to understand how *technologies can effectively be integrated* into educational contexts. Research investigating the relationships among technology, learners, and context knowledge within contexts designed to shape and integrate technology can inform instructional designers about successful strategies and their relationships to specific learning goals. Examples of technology being used to develop learners’ techniques, skills and cognition are discussed below.

Edelson et al. (1999) developed *Radiation Budget Visualizer* into a progressive technology that moves learners from a simple to more complex context. This technology tool is similar to Bonsttetter’s (2000) model differentiated types of inquiry that move learners to inquiry with teacher-guided, specific instructions to student-developed, open-ended questions. The technology aimed to address the motivation, accessibility, and practical constraints through a green house investigation activity. The RBV was one of the development stages of the CoVis project, it followed the use of another inquiry project, but the RBV used global data sets to investigate energy transfer in the earth atmosphere, temperature. One of the main issues the RBV tackled was the lack of prior knowledge need to work investigate the problems presented to them. Edelson et al.
(1999), discussed challenges of developing scientific visualization technologies to support inquiry-based learning by reviewing the design history of multiple projects.

*Model-It*: Metcalf, Krajick, & Soloway, (Jaocbson and Kozma, 2000) *Model-It* was designed to be an easy-to-use, object-oriented visual language with which students define their models quickly and easily, focusing their attention on the tasks of testing, analyzing, and re-examining their models and the understanding on which the models were based (Jacobson and Kozma, 2000). *Model-It*, is a learner-centered tool for building dynamic qualitative-based models. The goals of *Model-It* have been to support students, even those with only very basic mathematical skills. It was tested with four classes (100 students) of ninth graders for three modeling projects, each project for about one week (about four hours) over a two-month period. The tutorial section of the module was limited to one hour of class time. *Model-It* was able to see a growth from 20% to 85% usage of the specifying slope of relationship section and the use of *tableview* option. They also observed as the students learned the task, their expertise developed and the use of the supportive features of *Model-It* were reduced.

*Genscope* was designed to help students learn to reason and solve problems in the domain of genetics with learning goals that included both scientific explanations of phenomena and the nature of the scientific process (Horowitz & Christie, 2000). The researchers used an open-ended exploratory environment to address barriers encounter by learners in learning the genetic problems. The barriers noted by the researchers included the relation of prior knowledge to scientific concepts and terminology. They also wanted to transition learners from a deductive state to an inductive leaner. In the
first trial, the researchers assessed the pencil and paper test and did not have a significant
difference between a group of students, who had traditional instruction and those who
used Genscope. They reevaluated the assessment and used videotaped interaction of
students and transcripts of students’ reflection on the experience. The classroom-based
trails lasted approximately six weeks and were given to ninth grade students in the
Spring of 1997. The first couple of weeks provided exposure to Genscope, and later they
were presented with a exercises with limited direction. Upon completion, the researchers
found the learners were able to critically communicate the answers to the concepts, but
failed again to transition it to the pencil and paper test. They theorized four changes to
the project: (a) there might be a mismatch between the learned concepts and terminology
and the written assessment (b) the demonstration of knowledge with mouse and pencil
(c) evaluate test anxiety, and (d) when evaluated on paper, it seemed the learners failed
to relate visual and analytical skills with verbal description.

Wu, Krajick & Soloway (2001) developed eChem, a chemistry visualization tool,
the assist learners in building and manipulating molecular models. The computer- based
visualization tool addresses a diversity of learner backgrounds and promotes motivation.
The study aimed to investigate how learners used and developed their conceptual
understanding when using eChem to learn chemical concepts. eChem was guided by
three actions: (1) building molecular models, (2) visualizing multiple 3-D models, and
(3) comparing macro and micro representation. Seventy-one eleventh graders over a six-
week period worked with eChem to investigate a inquiry project entitled Is Our Drinking
Water Safe? The data were collected from curriculum materials, classroom video
recording, field notes, video recordings of the students using eChem, artifacts, pre-post tests, and interview transcripts. Their research showed that a technology-assisted inquiry allowed students to acquire a deeper conceptual understanding of chemical representation and concepts. As the learners understood their linkage between visual models and concepts increased, they were also able to develop better mental images.

Historically, scientists and educators have used computational models and scientific visualizations to investigate and explore complex systems and phenomena (Edelson et al., 1999). Recently, educators have seen the benefit of students’ use of computational and scientific visualization towards the investigation and exploration of complex systems and phenomena, particularly as the complexity of the authentic situation has been shown to affect the development of students’ conceptual knowledge. Lee and Songer’s (2003) research, for example, showed that students working with Kids as Global Scientist, a learning environment were able to develop rich understandings about scientific knowledge, thus informing the authors of ways to design tasks using technology that would prepare students to participate in social practices valued by the scientific community. Many of these types of instructional tools also have the potential to provide multiple contexts and opportunities for learning and transfer, for both students-learners and teacher-learners. To reveal the potential of scientific visualization, there needs to be “research conducted both small-scale studies and large–scale evaluations, to determine the goals, assumptions, and uses of technologies in classrooms and the match or mismatch of these uses with the principles of learning and the transfer of learning” (Bransford et al., 2000).
Learning Sciences research suggests several ways that technologies can be used to foster complex reasoning in science: scaffolding, feedback and revision, building local and global communities (Bransford et al., 2000). Scientists utilize technology to support higher-order thinking, including advanced analyses, modeling, and data representation (Songer, 2006). Edelson et al. (1999) recognized visualization, a powerful technology for scientific discovery, that renders complex data for visual interpretation, as a potentially powerful tool for science learning. He also recognized that databases, formed and used by scientists, could also be used by science learners to address challenges associated with background knowledge.

The versatility of computers plays an important role in the design and use of innovative software to address conceptual understanding of natural phenomena and of the processes used by scientists in their work of discovery (Kozma, 2000). Despite the many positive contributions of technology, the natural human action of anxiety can cause a negative outcome when learning methods are simulated through technology. Chua, Chen and Wong (1999) defined computer anxiety as a fear experience associated with the use of a computer or thinking about using a computer. Their research reported a negative relationship between computer anxiety and computer experience. They also found that students’ initial experiences with computer anxiety could decrease over time with an increase in comfort and confidence displayed by the instructor.

Mitra and Steffensmeier (2000) found that a computer-enriched learning environment was positively correlated with student’s attitudes toward computers in general, and the role of computers in facilitating teaching and learning. Schult and
McIntosh’s (2008) empirical study investigated the effects of computer-based examinations on computer anxiety and student anxiety, using an adapted State Anxiety in Computing Situation portion of the Computer Anxiety and Learning Measure (CALM) McInernery, Marsh & McInernery, 1999. The researchers gave the survey to 265 students prior to giving them exams. One group of the students took the exam as a traditional pencil and paper exam and the other group had their exam administered on computers. The results of the project did not show any difference in exam anxiety between pencil and paper students and computer-administered exams. However, they did see students who took the test with pencil and paper have computer anxiety. The researchers recommended more familiarity of students to technology prior to use, in order to relieve this computer anxiety. The researchers used the Computer Attitudes Questionnaire (CAQ) by Knezek, Christensen & Myashita (1998). For the purposes of their study, the researchers used subscales of Computer Importance, Computer Enjoyment and Computer Anxiety to determine the students’ attitudes toward using information technology (IT) (the computers) in their learning tasks. They stated “computer attitudes not only play an influential role in determining the extent to which students accept the computer as a learning tool but also future behaviors towards the computers such as using it for further study and vocational purposes”(p.17 ). The researchers found when positive attitude and methods were presented to the learners, the students had more positive attitudes toward the technology. These researchers also suggested future research to examine the impact of other variables such as computer literacy, level of comprehension, and computer-mediated learning environments.
Path Analysis

The previous portion of the chapter described the theoretical and empirical details relevant to the examination of variables included in the study. Path analysis was chosen to test the relationship between and among variables of interest, including three predictor variables and two possible independent variables, and performance on an inquiry task using Image-J technology and conceptual understanding of cellular biology content. Loehlin (2004) and Maruyama (1998) provided the theory and functionality behind the procedures of path analysis, which will be presented and discussed in detail in Chapter III.

In the early 1900, Charles Spearman represented his theory of intellectual performance with a path diagram. Even though a path diagram was used, it was not a path analysis. American geneticist Sewall Wright in the 1920s, while in search of the estimated size of effect from parents to the offspring, developed path analysis as an extension of multiple regression, a method of constructing and solving path diagrams (Loehlin, 2004). The introduction of path analysis into the social sciences came in the 1960s by Blalock and Duncan. They used path analysis to evaluate the “antecedents of success in attaining education and jobs” (Maruyama, 1998, p. 17). Their predictors consisted of social class, past academic achievement, social support toward educational attainment and job status, which showed a unidirectional flow.

Wright’s methodology composed of writing a system of equations, expressing the equations in terms of the correlations among the various variables, and solving for the unknown (Loehlin, 2004; Maruyama, 1998). Wright wrote in describing his works:
The present paper is an attempt to present a method of measuring the direct effect along each separate path in such a system and thus of finding the degree to which variation of a given effect is determined by each particular cause. The method depends upon the combination of knowledge of the degree of correlation among the variables in a system with such knowledge as may be possessed of the causal relations. In cases where causal relations are uncertain, the method can be used to find the logical consequences of any particular hypothesis in regard to them (Maruyama, 1998, p. 16).

Later, in additional writings Wright stated,

The method of path coefficients is not intended to accomplish the impossible task of deducing causal relations from the values of correlation coefficients. It is intended to combine the quantitative information given by the correlation with such qualitative information as may be at hand on causal relations to give a quantitative interpretation (Maruyama, 1998, p. 16).

Wright’s summation of his work gives the understanding of the building of a relationship of variables and regression weights. The multiple regression “identifies how well the predictors explain the criterion variable, but also which specific predictors are most important in predicting” (Maruyama, 1998, p. 21). Use of knowledge and theoretical considerations are the basis for building the relationships and model development in path analysis.
The Model

Maruyama (1998) stressed “The techniques and method doesn’t establish causality in the absence of experimental intervention. They cannot prove that any variable causes another variable. Rather, they provide an alternative and complementary methodology for examining plausibility of hypothesized models” (p. 6). In developing a model, the following three limitations should be taken into consideration so the correct deduction of causal relationships between variables exist. The limitations are as follows: (1) there must be a synchchronous variation or co-variation between X and Y; (2) there must be a temporal asymmetry or time ordering between the two; (3) additional causal factors must be purged because of possible relationships between X and Y. The limitations provide a framework for following the inception of the path analysis.

Path Diagram

A path diagram helps to visualize the interaction of variables in a path analysis. (Leohilin, 2004, p. 2). The following components are characteristics of a path diagram:

(a) Use of capitals letters such as A, B, C, Z etc. represent the variables.

(b) Boxes are used to describe observed measures. Observed measures are sometimes called indicators.

(c) Circles are used to describe theoretical variables. Other terms that are used are used latent variables, unmeasured variables and constructs.

(d) The relationship between the variables are represented by two types of arrows: (1) straight, one-headed arrow designates a causal relationship
between two variables, and (2) two-headed arrow designates a simple correlation between them.

(e) A causal arrow in a path will result in a change in the variable at the head of the arrow, all else being equal (i.e., with all other variables in the diagram held constant).

(f) One-way nature of this process - imposing a change on the variable at the head of the arrow - does not bring about a change in the tail variable.

(g) Curved arrows represent a noncausal relationship between two variables.

Maruyama (1998) and Loehlin (2004) stressed that causal models should be read as if it is surrounded by quotation marks (“causal”), for causal means “that if the model is true and if the theoretical variables are functional, then the relationships are as specified in the model”.

*Variables of the Path Analysis*

In constructing a path analysis, the following section describes the basic characteristics of the variables used in path analysis:

(a) Exogenous variables (Greek for “of external origin”) are so called because their causal sources lie external to the path diagram; they are causally independent with respect to other variables in the diagram, straight arrows may lead away from them but never toward them (Loehlin, 2004, p.4). The variables represent causal sources in the diagram. Alternate description is “independent” or “source” variable.
(b) Endogenous variables (Greek for “of internal origin”) have at least some causal sources that live within the path diagram, these variables are causally dependent on other variables downstream from source variables. Alternate descriptions are dependent or downstream variable (Loehlin, 2004, p.4).

As the path diagram develops, the observation of the variables has to follow the set of rules developed by Wright. These rules illustrate how the variables interact with each other indirectly and directly.

**Path Coefficients**

Leohlin (2004) identified path coefficient, “p” with two subscripts, the first for the variable affected (the effect) and the second for the determining or causal variable (Loehlin, 2004, p. 36). The path coefficient is the partial correlation coefficient between the endogenous and exogenous variables. The path coefficient will indicate the amount of expected change in the dependent variable as a result of the independent variable.

**Analysis of the Causal Model**

Obtaining Path Estimates: In using the path analysis developed by Wright (Loehlin, 2004) the correlation between any two variables in the diagram can be expressed as the “sum of the compound paths connecting these two points,” provided the following rules are followed in relation to the paths along the arrows:

(a) No loops: that a compound path must not go twice through the same variable

(b) No going forward then backward: After one has once gone forward along one or more arrows, it is not legitimate to proceed backwards along others.

(c) A maximum of one curved arrow per path
If the rules are followed, each lower case letter will stand for the magnitude or value of the particular causal effect or correlation (Loehlin, 2009 p.9). The numerical value of a compound path is equal to product of the values of its constant arrows. This numerical value with the addition of regression techniques to understand the size and nature of the relationships among the predictor variables, and there relationships, can be achieved if the endogenous variables of the path equation is not correlated with each other.

They are standardized partial regression coefficients; they express to what extent a change on the variable at the tail of the arrows is transmitted to the variable at the head of the arrow. Because they are partial regression coefficients, the change that occurs is depicted with all other variables in the diagram held constant. Because they are standardized partial regression coefficients, we are talking about changes measured in standard deviation units (p.12).

Because paths A and B are “standardized partial regression coefficients, also known in multiple regression problems as beta weights, path analysis can be multiple regression problems. So long as all variables are measured one can proceed to solve caused paths in a path diagram as beta weights in a series of multiple regression analyses. If the predictor variables were orthogonal (i.e. independent of one other), then the situation would be a simple one and the standardized regression coefficients would be the correlations of the predictor variable” (Loehlin, 2004, p.12).

Residual path coefficients are ascertained by ordinary regression analysis, as they have a direct regression interpretation. The general form of a residual path coefficient is $1-R^2$ where $R^2$ is the square of the appropriate multiple correlation coefficient. Loehlin
(2004) stated the $R^2$ is commonly referred to as the fraction or proportion of explained variance. Since standardized variables have a variance of one, the general expression $1-R^2$ is simply the portion of unexplained variance. Therefore, the residual path coefficient is simply the square root of the unexplained variance in the dependent variable in question.

**Summary of Chapter II**

*ER Project* is an instructional module using technology to allow students to construct a more realistic understanding of cell functioning using visual data sets. The module presents a supportive incorporation of staging and bridging activities to enhance, reinforce, and scaffold students’ inquiry experiences at particular stages in the instructional sequence. The technology-rich conditions associated with the *ER Project*, which are all computer-driven, include the use of a visual database, management of spreadsheets, exposure to unconventional instruction, and exposure to a complex, dynamic interactive model of the cell unlike students’ prior conceptions of the cell. The combination of data sets and visualization analysis software, *Image J*, allows students to microscopically view cells and intercellular movement as they naturally occur in living cells. As these components are combined the learners develop questions and analogies to the concepts being presented in the project. The learners’ end products consist of a video incorporating a group hypothesis, summary of conceptual understanding, and demonstrated analytical skills and reasoning ability.

The research indicates that learners’ prior knowledge, learning preference, and technology-related anxiety may mediate students outcomes associated with their use of
ER Project to understand the complex, contemporary notions of the cell, as well as their abilities to think and act like scientists in an inquiry-driven learning environment.

Prior knowledge has been shown to be significant to the development of learners, either from misconceptions or bridging of new concepts and phenomenon. The use of the ER Project gives students the opportunity to review their understanding of undergraduate cellular concepts, and begin to build or reconstruct their views and understanding of cellular structure and the ways in which scientists think about and do scientific research.

- Prior Knowledge $\rightarrow$ Conceptual Understanding of Natural Phenomena
- Prior Knowledge $\rightarrow$ Thinking and Working Like A Scientist

Previous research supports learning preference as having an influence on the ways in which learners process information. While ER Project was designed for all undergraduate learners, previous research suggests that there are positive interactions between students who have visual preferences for learning rather than those who prefer reading, listening, or movement.

- Learning Preference (Auditory) $\rightarrow$ Thinking and Working Like a Scientist

The computer-dependent nature of the ER Project could create a negative learning environment for students who have high levels of computer anxiety. High computer anxiety may be a variable that impinges upon students’ abilities to have sophisticated, expert interactions with the ER Project. These types of interactions may be necessary for students to develop higher-order understandings about the cell and scientific process.

- Computer Motivation $\rightarrow$ Thinking and Acting Like A Scientist
Finally, this study explores the effects of ER Project on the development of undergraduate biology students’ conceptual understanding of the cell and their abilities to transfer that information to a new context. Strong cases have been made for the use of inquiry information technology to enhancing students abilities’ to (a) understand complex nature phenomena, such as our current conceptions of the cell; and (b) to think and work like a scientist.

Prior research findings from the literature suggested a path analysis as a first step in understanding the effects of the ER Project on the development of undergraduate biology students’ conceptual understandings about the cell and their abilities to think and work like scientists. Chapter III details the path model that was developed to test relationships between and among variables identified from the literature review; the methods by which instruments were chosen or developed to measure the variables; and the specific statistical analyses that were performed to test the significance and strength of relationships between and among those variables.
CHAPTER III

METHODS

Chapter I described the potential benefits of instructional technology and authentic inquiry in enhancing the understanding of scientific concepts in college-level courses. This chapter also addressed concerns and the lack of definitive information elucidating the conditions under which instructional technology with and without authentic inquiry learning environments may be beneficial to undergraduate students’ understanding of complex relationships in various biological contexts, including those that exist within the cell. Chapter II reviewed literature that frames the dissertation: potential predictors of students’ performance in understanding the complex interrelationships of cellular infrastructure, including students’ prior knowledge, learning preferences, and attitudes toward computers (in particular, anxiety and motivation), and their use of an inquiry learning module (ER Project), which uses a particular form of visualization analysis technology (Image-J) to assist students in visualizing the movements of components within the cell’s infrastructure. This chapter ends with a brief review of path analysis, a statistical procedure employed in this investigation.

Research Design

This study strived to acquire information about the hypothesized relationships between Prior Knowledge, Learning Preferences, Attitudes toward Computers, Inquiry Task Performance and Conceptual Understanding. Two sources of data were used for evidence of student learning: (1) students’ performance on an inquiry task using Image-J
technology and (2) students’ subsequent conceptual understanding about the nature of the cell. In general, correlation was used to examine simple relationships between variables, and path analysis was used to examine the overall theoretical model. Predictor variables for this study included Prior Knowledge, measured by a pre-test on cell structure and movement; Learning Preference, measured by four subscales on a learning preference inventory; Computer Anxiety and Motivation with Computers, measured as two sub-scales on a Computer Attitudes Questionnaire; and, Inquiry Task Performance, measured by a scoring rubric. These variables are listed in Table 2.

<table>
<thead>
<tr>
<th>Table 2. List of Variables, Instruments, and Validity/Reliability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Prior Knowledge (Pre-test)</td>
</tr>
<tr>
<td>Prior Knowledge (Johnson &amp; Lawson, 1998)</td>
</tr>
<tr>
<td>Learning Preferences:</td>
</tr>
<tr>
<td>Visual, Aural</td>
</tr>
<tr>
<td>Reading/writing and Kinesthetic</td>
</tr>
<tr>
<td>(Fleming &amp; Mills, 1992)</td>
</tr>
<tr>
<td>(Fleming &amp; Mills, 1992)</td>
</tr>
<tr>
<td>Attitudes toward Computers (Modified)</td>
</tr>
<tr>
<td>(Knezek &amp; Christensen, 1996)</td>
</tr>
<tr>
<td>Inquiry Task Performance (ER Final Project)</td>
</tr>
<tr>
<td>Conceptual Understanding (Post-Test)</td>
</tr>
<tr>
<td>(Johnson &amp; Lawson, 1998)</td>
</tr>
</tbody>
</table>
Research Questions

The literature review carefully focused the area of interest and sets the foundation for the research questions below:

I. What are the simple relationships existing between variables chosen for examination in the present study?

II. What are the direct and indirect effects of the predictor variables included in this study on students’ Inquiry Task Performance and Conceptual Understanding?

To answer Question I, correlations were computed for all variables included in the study. This question was restated as a hypothesis with several sub-hypotheses, which are outlined with their calculations in Chapter IV.

To answer Question II, a causal model was formulated on the basis of previous research reports and theoretical considerations. The predictor variables were reduced from seven to three by comparing their correlation coefficient, beta weights, adjusted $R^2$ values and structural coefficients. The comparison of these values provided a stable group of predictors that related to the dependent variable in the causal model. The hypothesized paths were tested by regression techniques in which each endogenous variable was regressed by variables impinging upon it, with the last variable entered in the regression representing the determinant of the dependent variable in the path being examined. The standardized beta weight for the determinant variable obtained from the regression was then used as the partial path coefficient.

Context for the Study

The context of this study is based in an undergraduate biology course. The
undergraduate course catalog entry describes Biology 430 as follows: Biological Imaging. Credit 4. Still and video photography and photomicrography, computer-based digital image analysis and processing of biological images; theory and principles of light and electron microscopy including transmission and scanning electron microscopy; optical contrast methods for light microscopy including phase contrast, DIC, polarizing light and confocal laser scanning microscopy. Taught by a cellular biologist, this upper-division biology course typically meets three times a week for one hour in a traditional lecture setting and once a week in a laboratory setting for approximately three hours. During the three-hour laboratory, the learners experienced the topics and techniques discussed during lecture. These experiences consisted of simple demonstration and hands-on interaction with equipment and experimental use to enhance scientific understanding.

Participants

This study was conducted at a Research I university in the southwestern part of the United States. Participants were members of the course Biology 4030 - Biological Imaging offered in the Spring 2006 term within the university’s Department of Biology. While all 50 students in the course engaged in the Image-J inquiry activity, only 31 agreed to participate in the full study. The population consisted of nineteen female and twelve males. Fourteen of the students were juniors and seventeen were seniors and most had prior biology-related courses taught in the Biology Department.
The Intervention

The curriculum module, *ER Project*, was developed by Griffing, Stout, and Lane. In the module, students participated in inquiry-based learning about the dynamics of the endoplasmic reticulum and Golgi apparatus. The membrane system, the nuclear envelope, endoplasmic reticulum (ER) and Golgi apparatus (GA) are used by the cell to synthesize, transport and store protein and polysaccharide. The central question of the *ER Project* was: How does the organization and connectivity of these organelles change with time? In other words, how do they move? The question was introduced to focus students on visualizing and understanding cellular infrastructure and movement. The *ER Project* was split into three parts: (1) concepts, (2) *Image J* analytical software calibration and tutorial, and (3) development of hypothesis, analysis and final project.

The laboratory module combined information technology in science (in the form of a microscopy database) and inquiry learning. The dataset was formed from images (Figure 2) taken by confocal fluorescence microscopy of tobacco leaf cells that were expressing green fluorescence protein in both the ER and GA. The module was presented to the students in the form of a booklet and compact disc (CD).
The booklet contained information on these concepts: (1) confocal microscopy, cellular organization and movement, (2) tutorial on the analysis of ER and GA dataset, (3) development of hypothesis with analysis, and (4) final video. The CD contained the *ER Project* dataset of 55 images, which when compressed with *Image J* the data sets produce a movie clip.

Figure 3 is a screen capture of *Image J*, the public domain Java image-processing program that can display, edit, analyze, process, and save images. Using *Image J*, one is able to calculate the area and pixel value statistics for user-defined selections, while measuring distances and angles. It supports standard image processing functions such as contrast manipulation, sharpening, smoothing, edge detection and median filtering. Most importantly, *Image J* provides spatial calibrations to real-world dimensional measurements in units such as millimeters.
The module was scaffold to facilitate participants’ understanding of internal cellular movement, scientific analysis, and research methodology. Participants became knowledgeable of *Image J* and the *ER Project* dataset by following the tutorial section of the module. In the tutorial, the students first calibrated the *Image J* software. After calibration, they used *Image J* to inquire into the relationship between fast and slow lanes and branching of the endoplasmic reticulum. In seeking an answer to the questions about this relationship they must identify fast and slow lanes in a particular region of interest (see quadrilateral in Figure 4).

Figure 3. Capture Image of *Image J*

Figure 4. Image of ROI with *ER Project* Data Sets
The region of interest (ROI) (Figure 4) was identified by the yellow and red outlined areas of the dataset image. Once the ROI were identified, the students determined the fast and slow lanes by observing the movement of the Golgi along the endoplasmic reticulum. After the observation, they quantified the number of branches in the regions and developed a conclusion.

After finishing the tutorial the students were guided into developing and analyzing their own hypothesis in relation to the given dataset. The students were required to provide a central model (analogy) to their newly developed research question. After they developed their research question, they engaged in scientific investigation by preparing a hypothesis, method of analyses, results, and conclusion. All of these items were illustrated in a final product video, which students saved on a compact disc.

**Administration Techniques**

All participants had the same lecture and laboratory instructor. They met three times a week for lecture (Monday, Wednesday, Friday 11:30-12:20 pm) and once a week for laboratory (either Tuesday, Wednesday or Thursday 1:00-4:00 pm). The participants met at their assigned times for laboratory to participate in the intervention, which lasted three weeks.

All students were required to participate in the intervention, as the *ER Project* was a part of class expectations. Students refusing to allow their work to be used for research were still required to complete the project. Those students’ data were not used for research purposes. The students worked in groups of two for the duration of the
The ER Project was given to the students mid-semester; the content was discussed in the lecture while most of the project was done during laboratory sessions or after regular class time. Each group followed the timeline, as described below, of testing and using the intervention.

After Week One, participants completed consent forms, learning preference questionnaires, attitude toward computers questionnaires, and pre-tests. During Week Two, participants used the ER Project, in which they followed the tutorial for the module. After the tutorial, they developed and tested their own hypotheses using the ER Project data sets. Upon completion of analyzing their hypotheses, they saved their information in video format on compact disks. In Week Three, participants completed post-tests on cellular content and structure on WebCT.

The participants’ consent form, learning preference questionnaire, attitudes toward computers questionnaire, pre-test, post-test, and rubric scoring table were all stored in individual folders only labeled with the last four digits of the participants’ university identification number (UIN); responses from the participants were recorded in a notebook prior to inputting them into SPSS.

Statistical Analysis

Raw data from all instruments were transferred from participants’ answer sheets to a notebook and to an electronic database. All analyses were conducted using Statistical Packages for the Social Sciences (SPSS) version 18.0 (SPSS, Inc., Chicago).
**Preliminary Analysis**

The preliminary analysis consisted of descriptive statistics and score reliabilities, which are discussed, in Chapter IV.

**Correlational Analysis: Question I**

The correlational analyses associated with Question I were calculated using the SPSS version 18.0 Pearson Correlation. The correlational analysis was performed prior to the testing of the path model. To access the Pearson correlation with SPSS, one begins by engaging the Analyze Tab. After clicking the Analyze tab, one follows these steps to proceed: Analyze ➔ Correlate ➔ Bivariate. Once the Bivariate tab is engaged the variable dialog box appears. In the dialog box, the predictor and dependant variables are transferred for analysis. Upon transfer, one checks the Pearson box and execute (Field, 2005). The output is a correlation matrix of the variables. The Pearson $r$ correlation coefficient is a measure of the amount of variability in one variable that is explained by the other. It is important to mention that correlation coefficients say nothing about which variable causes the other to change. The use of path analysis, with its understanding of assumptions, however, allow causal relationships to be inferred.

Regressions were run on multiple combinations of the predictor variables. The aim of the regression was to achieve the highest adjusted $R^2$ and beta weights. The procedure to calculate the adjusted $R^2$ and beta weights are as follows: Analyze ➔ regression ➔ linear ➔ input dependent and independent variables, while saving the standardized predictor variables. The results were discussed in Chapter IV.
The standardized predictor variables were correlated with the dependent variables to obtain the structure coefficients. The structure coefficients were calculated by the following steps: Analyze → Correlate → Bivariate. The results will be discussed in Chapter IV.

Regression Analysis: Question II

Regression analyses associated with Question II were performed using the SPSS version 18.0 program. Multiple R (Field, 2005) is the correlation between the observed values and the values of the predicted by the multiple regression models. Therefore, large values of Multiple R represent a large correlation between the predicted and observed values of the outcome. A Multiple R of 1 represents a situation in which the model perfectly predicts the observed data. As such, multiple R is a gauge of how well the model predicts the observed data. To get to the regression dialog box one chooses the Analyze Menu and select Regression and then Linear (Analyze → Regression → Linear). The path coefficients (beta weights) are used to express the relationships within the model. The model relationships were tested using a structural equation modeling software AMOS version 17.0, in conjunction with SPSS version 18.0. The software presented models in an intuitive path diagram to show hypothesized relationships among variables.

In addition to evaluating the beta weights, the following data results were evaluated in estimating the number of parameters in the model. The normal fit index (NFI), comparative fit index (CFI), root mean square error of estimate approximation (RMSEA), goodness of fit (GFI), and adjusted goodness of fit (AGFI). The ideal NFI is
greater than 0.9, which looks at the difference between the two models’ chi-square values. The CFI is similar to the NFI, and is also good for a small sample. The ideal CFI is greater than 0.9. The RMSEA, which compares the lack of fit with the model, should have an ideal result of 0.05 or less. The RMSEA is also affected by sample size, much more sensitive in large sample sizes. The GFI tells what proportion of the variance in the sample variance-covariance matrix the model accounts for. The ideal GFI is greater than 0.9. The last of the evaluated goodness of fit results are AGFI. The ideal adjusted goodness of fit index is 0.7 or greater. The AGFI is the value adjusted for the number of parameters in the model (Loehlin, 2004).

Summary of Chapter III

To effectively address the relationship between the mediating learning variables, the assessment of validity was a concern while conceptualizing the project. Concerns of design, choice of subjects, instrumentation, intervention, and statistical analysis were outlined in this chapter.

In general it was assumed that the results of the testing of the variables would reveal valid information regarding the relationship between pairs of variables included in the study. Finally, it was deemed that the formulation of a model of scientific reasoning based on the results of path analytic methods would yield valid results.
CHAPTER IV

RESULTS

The primary purpose of this research was to assess the effects of learning characteristics of undergraduates in a technology-supported, inquiry-learning environment designed by biology instructors at a major Research I university (Texas A&M University). A second purpose of the research was to develop an understanding of the complex relationships and interactions among learner characteristics, prior knowledge, conceptual understanding, and inquiry skill development while undergraduates were engaged in the ER Project. This chapter provides the narrative for the results of the analysis of data collected from the instruments and procedures described in Chapter III. This narrative will also be used to prepare the pathway toward the conclusions and implications discussed in Chapter V.

Two questions and their associated general hypotheses were tested in the present research. To answer the first question, the simple relationships among the variables chosen for inclusion in the study were tested. These relationships were represented as sub-hypotheses dealing with how each predictor variable and dependent variable interact. The results of this analysis also provided support for the development of a hypothetical model for Conceptual Understanding that included Inquiry Task Performance and a number of other variables supported in the literature to as potential mediators in learners’ increased understanding of complex scientific information about cellular functioning. To answer the second question, a path diagram was developed to depict hypothesized relationships among and between the predictor variables with the
two linked dependent variables, *Inquiry Task Performance* and *Conceptual Understanding*. The path diagram was then analyzed using path analysis with some modifications to accommodate for the small numbers of students involved in the study.

For the purposes of simplicity in this chapter, the results are explained in terms of the associated hypotheses for the two research questions. While this chapter provides the results of testing these hypotheses, Chapter V contains the discussion of these findings in the form of answers to the research questions.

**Instrument Description**

Table 3 contains the descriptive information regarding each of the instruments, including means, standard deviations, and ranges, for the 31 students participating in this study. In addition to the descriptive, the reliability of each instrument was achieved.

**Testing Question I**

Question I proposed relationships between variables chosen for analysis in this study. Question I: *What are the correlational relationships of the learners’ characteristics while using the ER Project for conceptual understanding?*

- a. Prior Knowledge and Conceptual Understanding;
- b. Prior Knowledge and Inquiry Task Performance;
- d. Auditory Learning Preference and Inquiry Task Performance;
- e. Reading/Writing Learning Preference and Inquiry Task Performance;
- f. Kinesthetic Learning Preference and Inquiry Task Performance;
- g. Computer Anxiety and Inquiry Task Performance;
Motivation towards Computers and Inquiry Task Performance; and

Inquiry Task Performance and Conceptual Understanding?

<table>
<thead>
<tr>
<th>Table 3. Descriptive Statistics for the Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior Knowledge (Pre-Test)</td>
</tr>
<tr>
<td>Visual Learning Preference (VARK Subscale)</td>
</tr>
<tr>
<td>Auditory Learning Preference (VARK Subscale)</td>
</tr>
<tr>
<td>Read/Write Preference (VARK subscale)</td>
</tr>
<tr>
<td>Kinesthetic Learning Preference (VARK subscale)</td>
</tr>
<tr>
<td>Computer Anxiety (CAQ-Anxiety Subscale)</td>
</tr>
<tr>
<td>Motivation Towards Computers (CAQ-Motivation Subscale)</td>
</tr>
<tr>
<td>Inquiry Task Performance</td>
</tr>
<tr>
<td>Conceptual Understanding (Post-test)</td>
</tr>
</tbody>
</table>
The correlation matrix presented in Table 4 provides the correlations calculated for each pair of variables in the study. All correlation coefficients in this table were subjected to one-tailed tests of statistical significance. Observations of the highest correlation coefficient are indicated in Table 4.

**Summary for the Results of Question I**

Correlation coefficients for each of the nine relationships between independent and dependent variables are contained in Table 4. Of the nine relationships, one was statistically significant at the level of <0.01 and two relationships were significant at the level of < 0.05.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Visual Learning Preference</td>
<td>-0.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auditory Learning Preference</td>
<td>-0.2</td>
<td>0.03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reading/ Writing Learning Preference</td>
<td>0.46(**)</td>
<td>-0.18</td>
<td>-0.15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kinesthetic Learning Preference</td>
<td>0.27</td>
<td>-0.05</td>
<td>-0.11</td>
<td>-0.06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer Anxiety</td>
<td>0.44(**)</td>
<td>0.02</td>
<td>0.12</td>
<td>0.17</td>
<td>0.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motivation Towards Computers</td>
<td>0.29</td>
<td>0.01</td>
<td>-0.46(**)</td>
<td>0.38(*)</td>
<td>0.35(*)</td>
<td>0.01</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inquiry Task Performance</td>
<td>-0.33(**)</td>
<td>0.24</td>
<td>-0.34(*)</td>
<td>-0.13</td>
<td>0.14</td>
<td>0.05</td>
<td>0.05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conceptual Understanding</td>
<td>0.81(**)</td>
<td>-0.23</td>
<td>-0.17</td>
<td>0.2</td>
<td>0.42(**)</td>
<td>0.28</td>
<td>0.07</td>
<td>-0.27</td>
<td></td>
</tr>
</tbody>
</table>

** Correlation is significant at the 0.01 level of significance
* Correlation is significant at the 0.05 level of significance
The relationship between Prior Knowledge and Conceptual Understanding ($r = 0.813, p < 0.01$) was significant. This relationship showed a positive linear correlation between Prior Knowledge and Conceptual Understanding.

While statistical significance was also found between Prior Knowledge and Inquiry Task Performance ($r = -0.33, p = 0.03$) and Auditory Learning Preference and Inquiry Task Performance ($r = -0.34, p = 0.04$), both of these relationships were negatively sloped. The inverse relationship illustrates the increase in one variable with a decrease in the other variable. All other relationships involving Inquiry Task Performance were not statistically significant. These relationships included Inquiry Task Performance and Visual Learning Preference, Reading/Writing Learning Preference, Kinesthetic Learning Preference, Computer Anxiety, Motivation toward Computers, and Conceptual Understanding. Of note are the relationships between Computer Anxiety and Inquiry Task Performance and Motivation toward Computers and Inquiry Task Performance, which were considered in the revision of the predictor variables used to develop the path diagram. Their correlation with Inquiry Task Performance was one of the conditions in determining the best set of variables. The reduction of the variables provides an opportunity to see a more efficient view of the predictor variables with the dependent variables.

**Testing Question II**

Answering Question II required the comparison of the direct and indirect effects of the variables included in this study on students’ Inquiry Task Performance and Conceptual Understanding. To develop a hypothesis for these effects, a causal model
was formulated on the basis of the existing theoretical model proposed from the results of the literature review (see Chapter II). A process of path analysis, outlined by Loehilin (2004), Maruyama (1998) and Field (2005), was used to test the model.

A path diagram was constructed to represent the hypothesized relationships between predictor variables and the dependent constructs of interest. In comparison to simple multiple regression, regression analyses performed in path analysis require a simultaneous comparison of relationships between and among independent and dependent variables. When multiple predictors are hypothesized as having relationships with a dependent variable, variance is assumed to be shared among the predictors impinging upon the dependent variable. Results of the testing of simple relationships between pairs of variables in the answer to Question I were used to examine potential determinants of both Inquiry Task Performance and Conceptual Understanding. The small number of participants in this study (N= 31) led to some exploratory work before the development of the final model to be tested.

First, the least salient variables from the results of the correlation analyses were excluded. These variables were chosen for exclusion by calculating and comparing correlation coefficients (Table 4), adjusted $R^2$, Beta weights and structure coefficients (Table 5). The adjusted $R^2$ and Beta weights were calculated using regression analysis. The structure coefficients were calculated by correlating the predicted value for the dependent variable with each of the predictor variables. Each of the variables was observed in combinations with other variables to determine the highest potential predictor values for Inquiry Task Performance. When these analyses were performed,
the three highest adjusted $R^2$ values achieved with the multiple combinations of the predictor variables for Inquiry Task Performance were 0.243 (Prior Knowledge, Auditory Learning Preference, Kinesthetic Learning Preference), 0.216 (Prior Knowledge, Auditory Learning Preference, Visual Learning Preference) and 0.192 (Prior Knowledge, Auditory Learning Preference, Motivation toward Computers).

Table 5. Adjusted $R^2$, Beta Weights and Structure Coefficient

<table>
<thead>
<tr>
<th>Predictor Variable</th>
<th>Dependent Variable</th>
<th>Adjusted $R$ Squared</th>
<th>Beta Weight</th>
<th>Structure Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior Knowledge</td>
<td>Inquiry Task</td>
<td>.081</td>
<td>-.334</td>
<td>.334</td>
</tr>
<tr>
<td></td>
<td>Performance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auditor Learning Preference</td>
<td>Inquiry Task Performance</td>
<td>.075</td>
<td>-.0.325</td>
<td>.325</td>
</tr>
<tr>
<td>Motivation toward Computers</td>
<td>Inquiry Task Performance</td>
<td>-.032</td>
<td>.047</td>
<td>.047</td>
</tr>
<tr>
<td>Prior Knowledge</td>
<td>Conceptual</td>
<td>.650</td>
<td>.813</td>
<td>1.0</td>
</tr>
<tr>
<td></td>
<td>Understanding</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inquiry Task</td>
<td>Conceptual</td>
<td>.038</td>
<td>-.265</td>
<td>.265</td>
</tr>
<tr>
<td></td>
<td>Performance</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Calculating the Structure Coefficients for the Predictor Variables

Beta Weights are partial weights, meaning their “magnitude is related to two factors: the strength of the relationship between a predictor variable and dependent variable and the mix of any other predictor variables” (Norman & Streiner, 2007, p. 149). Structure coefficients show the amount of variance accounted for in the dependent variable by each predictor variable. Structure coefficients can be computed by
computing the correlation between the predictor variables and the dependent variable divided by a multiple correlation (Norman & Streiner, 2007, p. 149).

**Testing the Hypothesized Path Diagram**

The path diagram illustrated in Figure 5 was devised from the initial seven-predictor variables mentioned in. These three predictor variables (*Prior Knowledge, Auditory Learning Preference, and Motivation toward Computers*) were achieved from comparing the adjusted $R^2$, beta weights and structure coefficients. Amos 17 was used to test the predictors and the dependent variables. The Regression was used to test the hypothesized path diagram (Figure 5) in which each direct and indirect variable was regressed with the dependent variables.

![Path Diagram](image.png)

Figure 5. A Revised Model for Conceptual Understanding displaying hypothesized paths between variables that were tested by path analysis techniques. Results from simple and multiple regressions were used to evaluate the path coefficients according to Maruyama (1998) and Field (2005).

In each regression, the dependent variable being examined was the last variable entered into a regression with each preceding variable entered before it. The path
coefficient obtained from the standardized beta weights of the three chosen predictor variables with the two dependent variables (i.e., Inquiry Task Performance and Conceptual Understanding) were obtained from the regression used to represent the path coefficient. Standardized Beta weights were useful in comparing the importance or strength of each independent variable. The relative size of the coefficients is an indicator of the strength of the variables.

**Summation of Procedures Resulting in Path Coefficients**

Figure 6 illustrates the five regressions performed in order to obtain the path coefficients for the model predicting Conceptual Understanding. The five regressions are summarized in Table 6. These path coefficients values are also included in the path diagram shown in Figure 5.

![Path Diagram](image-url)

Figure 6. Resulted Model for Conceptual Understanding with the Meditative Inquiry Task Performance and Predictors.
The path diagram in Figure 6 displays the path coefficients resulting from multiple regressions performed between the predictor variables of Prior Knowledge, Auditory Learning Preference, and Motivation Toward Computer, with Inquiry Task Performance and Conceptual Understanding.

Table 6. Path Coefficients for Path Diagram

| Multiple regression to determine the path coefficient P91 (From Conceptual Understanding to Prior knowledge) | 0.97 |
| Multiple regression to determine the path coefficient P81 (From Prior Knowledge to Inquiry Task Performance) | -0.12 |
| Multiple regression to determine the path coefficient P83 (From Auditory Learning Preferences to Inquiry Task Preference) | -0.84 |
| Multiple regression to determine the path coefficient P87 (From Motivation toward computers to Inquiry Task Performance) | -0.20 |
| Multiple regression to determine the path coefficient P98 (From Inquiry Task Performance to Conceptual Understanding) | 0.03 |

A strong positive path coefficient (0.97) was confirmed between Prior Knowledge and Conceptual Understanding. Prior Knowledge was an efficient predictor of Conceptual Understanding. Despite the positive relationship with Conceptual Understanding, Prior Knowledge demonstrated a negative relationship with Inquiry Task Performance. The beta weight resulting for the relationship between these variables was -0.12, illustrating a very limited direct effect of Prior Knowledge upon Inquiry Task Performance. The shared variance between these two variables is very low, indicating a very weak relationship between them. The negative beta weight of -0.84 between Auditory Learning Preference and Inquiry Task Performance, however, shows a high
adverse direct effect on Inquiry Task Performance. The last learner characteristic, Motivation toward Computers, resulted in a negative low path coefficient with Inquiry Task Performance; the resulting beta weight was -0.20. The magnitude of the beta weight between these two variables is considered to be small, so the inverse direct effect upon Inquiry Task Performance is minimal. The last observed relationship was between Inquiry Task Performance and Conceptual Understanding, which resulted in a relationship with a beta weight of 0.03. The path coefficient shows a minute predictability of inquiry task performance on conceptual understanding.

In addition to looking at the path coefficient, five descriptive fit statistics were observed for the structural model. The data showed the NFI was 0.76 and the CFI was 0.81. Ideal values for these parameters are greater than 0.9. These two parameters are seen to work well with small samples. The RMSEA for the model was 0.23, the ideal value is less than 0.05. The data showed the GFI was 0.29 and the AGFI was 0.58. The ideal GFI is 0.9 and the ideal AGFI was 0.70. Both of these scores fall short of the ideal value. None of the values fall within the required parameters. The results of this path diagram suggest the need to continue observing other predictors that may influence Inquiry Task Performance and Conceptual Understanding.

The data related to the predictability of the learners’ characteristics showed that Prior Knowledge was the best predictor of Conceptual Understanding, without intervention of the ER Project. The influence of other variables was so minute that the results left more questions than answers. This uncertainty was supported by the error and low path coefficients found in the path diagram, questioning if there are other variables
or combinations of variables, which could be used to predict the learners’ Inquiry Task Performance on the use of the ER Project or Conceptual Understanding.

**Post Hoc Analysis**

In a Post Hoc Analysis, other combinations of the predictor variables were observed. The combination in which Visual Learning Preference was switched for Auditory Learning Preference was a best fit to the model (Figure 7). The post hoc path coefficients increased, the error decreased and more of the values of the best-fit data descriptive fell within the desired parameters.

Figure 7. Post Hoc Path Diagram of Predictor Variables, Inquiry Task Performance and Conceptual Understanding.

The diagram shows that the Visual Learning Preference of the learner had stronger influence than Auditory Learning Preference; also that the Motivation Toward
Computers influence on the inquiry task performance become stronger. Table 7 shows a summary of the path coefficients for the post hoc path diagram.

<table>
<thead>
<tr>
<th>Table 7. Post Hoc Path Coefficients for Path Diagram</th>
<th>Beta Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple regression to determine the path coefficient (From Conceptual Understanding to Prior knowledge)</td>
<td>0.97</td>
</tr>
<tr>
<td>Multiple regression to determine the path coefficient (From Prior Knowledge to Inquiry Task Performance)</td>
<td>-0.10</td>
</tr>
<tr>
<td>Multiple regression to determine the path coefficient (From Visual Learning Preferences to Inquiry Task Preference)</td>
<td>0.37</td>
</tr>
<tr>
<td>Multiple regression to determine the path coefficient (From Motivation toward computers to Inquiry Task Performance)</td>
<td>0.99</td>
</tr>
<tr>
<td>Multiple regression to determine the path coefficient P98 (From Inquiry Task Performance to Conceptual Understanding)</td>
<td>0.03</td>
</tr>
</tbody>
</table>

Table 8 provides a comparison of descriptive summaries of alternative combinations of variables that may be the best-fit model. The scenarios were analyzed using AMOS, and a legend is provided below to identify the individual models.
Table 8. Post Hoc Best Fit Model Summary

<table>
<thead>
<tr>
<th>Model</th>
<th>Ideal</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>NFI</td>
<td>&gt;.90</td>
<td>0.758</td>
<td>0.818</td>
<td>0.829</td>
<td>0.673</td>
<td>0.672</td>
<td>0.735</td>
<td>0.794</td>
<td>0.669</td>
</tr>
<tr>
<td>CFI</td>
<td>&gt;.90</td>
<td>0.814</td>
<td>0.886</td>
<td>0.923</td>
<td>0.710</td>
<td>0.710</td>
<td>0.789</td>
<td>0.871</td>
<td>0.705</td>
</tr>
<tr>
<td>RMSEA</td>
<td>&lt;.05</td>
<td>0.237</td>
<td>0.188</td>
<td>0.135</td>
<td>0.301</td>
<td>0.294</td>
<td>0.248</td>
<td>0.181</td>
<td>0.302</td>
</tr>
<tr>
<td>GFI</td>
<td>&gt;.90</td>
<td>0.857</td>
<td>0.902</td>
<td>0.914</td>
<td>0.839</td>
<td>0.800</td>
<td>0.850</td>
<td>0.899</td>
<td>0.818</td>
</tr>
</tbody>
</table>

**Model A**
Predictors: Prior Knowledge, Auditory Learning Preference, and Motivation toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual Understanding
In Model A, this is the initial model used in the experiment. The model showed the best-fit data for Prior Knowledge, Auditory Learning Preference and Motivation toward Computers contribution to understanding their relationship to Inquiry Task Performance and Conceptual Understanding.

**Model B**
Predictors: Prior Knowledge, Auditory Learning Preference, Anxiety toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual Understanding
In Model B, this model switched the Anxiety toward computers variable for the Motivation toward Computer variable.

**Model C**
Dependent Variables: Inquiry Task Performance and Conceptual Understanding
In Model C, This model has the Visual Learning Preference variable in the place of the Auditory Learning Preference.

**Model D**
Predictors: Prior Knowledge, Kinesthetic Learning Preference, Motivation toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual Understanding
In Model D, Kinesthetic Learning Preference replaced the Auditory Learning Preference from the initial model.

**Model E**
Predictors: Prior Knowledge, Reading/ Writing Learning Preference, Motivation toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual Understanding
In Model E, Reading/Writing Learning Preference predictor variable was exchanged for the Visual Learning Preferences predictor variable.

**Model F**
Predictors: Prior Knowledge, Kinesthetic Learning Preference, Anxiety toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual understanding
In Model F, the Kinesthetic Learning Preference and Anxiety toward Computers were exchanged for Visual Learning Preference and Motivation toward Computers of the initial model.

**Model G**
Predictors: Prior Knowledge, Visual Learning Preference, Anxiety toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual understanding
In Model G, the Anxiety toward computers preplaced Motivation toward Computers of the initial model.

**Model H**
Predictors: Prior Knowledge, Reading /Writing Learning Preference, Anxiety toward Computers
Dependent Variables: Inquiry Task Performance and Conceptual Understanding
In Model H, the Reading /Writing Learning Preference predictor and Anxiety towards Computers replace Auditory Learning Preference and Motivation toward Computers.
Comparison of alternative combinations of predictors presented various outcomes, but of the eight different combinations, Model "C" contained 3 of the 5 ideal values for the best fit descriptive. The NFI value was close to the ideal score. As shown in Table 4.7, Model "C" values were as follow NFI= 0.923, CFI= 0.829, RMSEA= 0.135, GFI=0.914 and AGFI= 0.743. These best fit descriptive values and path coefficients were the best out of all of the combination.

Summary of Chapter IV

In summarizing Chapter IV, I observed the correlation of the variables, reduced the predictor variables for the model on the basis of path analytic methods, and provided an alternate best-fit model.

The first research question required the evaluation of relationships between pairs of variables, which was done by calculating and comparing correlation coefficients. Findings from the results of answering the first research question provided statistical support for the selection and subsequent examination of variables within a model in order to answer the second research question, which required a reduction in the number of predictor variables. As the number of students in this study was small, predictor variables were evaluated in sets of three to make a choice of predictor variables to be included in the path model. As a result, this chapter explains (a) the choices that were made to develop a path model and (b) the results of testing the model by comparing standardized beta weights associated with a number of multiple regressions. The initial model of choice was Prior Knowledge, Auditory Learning Preference, and Motivation toward Computers as the predictors and Inquiry Task Performance and Conceptual
Understanding as the dependent variables. This model showed Prior Knowledge to have strong influences on conceptual understanding but it had limited influence toward inquiry task performance. The other predictors didn’t show the same relationship.

Results of the first model suggested the need for more analysis regarding the combination of the predictor variables. A post hoc analysis of the variables led to the following findings. First, the findings of the path analysis supported Prior Knowledge as having a strong influence on Conceptual Understanding but not Inquiry Task Performance. Second, Visual Learning Preference had more of an influence on Inquiry Task Performance than Auditory Learning Preference. Finally, Motivation Toward Computers had a strong relationship with Inquiry Task Performance performed during the ER Project. The last tested pairing of the dependent variables revealed that learners’ performance on Inquiry Task Performance (i.e., the measure associated with students’ engagement in the ER Project) had limited contributions to their Conceptual Understanding of cellular movement and structure. We also saw that student’s success on the module had limited influence on the learners’ conceptual understanding of cell structure and movement. With these findings, Chapter V provides a discussion of these findings in the light of answering the research questions and reflecting on the implications of this study for further research and classroom practice related to the use of inquiry-rich, technology-mediated learning modules in undergraduate cellular biology classes.
CHAPTER V

DISCUSSION OF THE RESULTS:
CONCLUSIONS, IMPLICATIONS, AND RECOMMENDATIONS

The aim of this study was to further our understanding about how and what undergraduate biology students learn in a technology-supported, inquiry learning environment designed specifically to develop rich understandings about intercellular movement and scientific processes. The *ER Project* was created to provide such an environment to college juniors and seniors in an advanced cell biology class. Technology in the forms of microscopy image database and analytical software (*Image J*) were incorporated into the *ER Project* to provide students with opportunities to visualize the intercellular movement of organelles, fluorescent microscopy and scientific evaluation (i.e., use of *Image J*). The visualization of intercellular movements focused on the interaction of the Golgi apparatus and endoplasmic reticulum. The fluorescent microscopy produced images of these cellular organelles in a more economical visual medium for classroom instruction. The use of *Image J* provided an opportunity to analyze digital images, including the selection of specific regions of interest and the observation of movement between points.

Inquiry was incorporated into *ER Project* to provide students working in groups with opportunities to use this technology in an environment of “working and thinking like scientists.” They used technology and inquiry to answer questions about the rate of movement of Golgi apparatus along endoplasmic reticulum, identification of fast and
slow tracks, parallels to the concept of the intercellular movement, and alternative questions answered through the analysis of the image database.

Many undergraduate instructional modules (Edelson, 2001; McComas & Moore, 2001; Edelson et al., 2006; Wu et al., 2001; Kozma, 2000; Howitz & Chrisitie, 2000) have been developed to produce real-world scientific contexts in which learners manipulate information in a scientific investigation manner. These modules included databases of chemical structures, global climate change, and environmental effects. These designers have faced problems that the ER Project designers faced in creating an effective instructional module that also would produce a real-world scientific context involving the intercellular movement of organelles.

A learning environment fusing two innovations – technology and inquiry – begged multiple questions to the learning environment designers of the ER Project. Would this environment be advantageous in developing learners’ knowledge about modern conceptions related to intracellular processes? Would the environment be “too novel,” and thus overwhelm students’ abilities to learn? What about students’ learning expectations? Would those successful in learning in more traditional environments be intimidated by an environment requiring them to think and act like scientists? And what about students’ own preferences regarding the ways in which they prefer to learn and use computers as learning tools?

ER Project provided a novel context and unique learning environment designed to (a) allow students opportunities to develop and use abilities to think and act like scientists and (b) conceptually organize their understanding about the cell to include
modern understandings about the dynamic nature of cellular processes. As I worked with my mentor to collaboratively design ER Project, my own research questions began to form around the relationships that might exist between the learning environment and learners’ preferences for learning and their motivations towards the use of computers. Specifically, I wanted to know how students learned and what they learned when they were engaged in the ER Project learning environment. The ER Project required students to use the computer as a scientific tool of discovery and inquiry as a legitimate process for learning science. Our expectations in designing ER Project were that engagement in the project would enhance students’ understanding of science as a process and their knowledge of the cell. However, my own work with undergraduate students in my own teaching led me to ask questions about the effects of student motivation and learning preferences on students’ engagement in a learning environment dissimilar to anything they had experienced before.

Goal

The goal of this study was to explore students’ interactions within the learning environment of the ER Project to assess the effectiveness of an innovative database instructional technology as a learning tool and thus provide a model for an efficient method of instruction for students in an undergraduate laboratory course. In order to assess the effectiveness of the tool, I wanted to understand more about the role of learners’ characteristics in their interactions with technology-supported, inquiry-based instruction.
Review of Results

The first two chapters of this dissertation introduced the context and previous research associated with innovative learning environments employing technology and/or inquiry learning. Chapter I provided a description of inquiry instruction with regard to undergraduate students in a biology classroom, focusing on students variables that may contribute to students’ development of inquiry learning skills, to students’ conceptual understanding of cellular processes, or both. Chapter II provided a thorough discussion of topics related to the purpose of this investigation. The review of the literature indicated support for both technology and inquiry as media that can effectively present scientific content to science learners. In addition, I also identified and discussed a number of student learning variables that might possibly interact with the learning environment of the ER Project to either contribute or hinder learners’ abilities to think and act like scientists and/or to develop deep conceptual understandings about cellular processes. The review of research indicated that findings were not so clear regarding the relationships between and among learners’ characteristics, their receptivity to inquiry task learning, and their development of deep conceptual understanding.

Learner’s Characteristics: Prior Knowledge, Learning Preference, and Motivation toward Computers

The call for reform is related to the new developments in the sciences, which have branched into multiple evolutionary pathways. The utilization of the computer in conjunction with instrumentation has produced learning environments that require analytical skills in addition to content retention. These new pathways have shown an
intermingling among the science disciplines, each having some contribution to the other, reducing the isolation and causing more collaboration. The biological survey courses provide the foundation that prepares learners to be successful in upper-level biology courses. Environments that present situations where learners *experience* content, not just *memorize* it, are thought to be supportive of the development of deeper understandings of biological knowledge. The experiencing of the content in this way reflects the synergy between scientific research and science education. The learner’s engagement in scientific inquiry has been envisioned as a platform for the synergy. Scientific inquiry learning puts learners in an environment that can give them a clear view of more expert scientific practices (Blumenfeld, Kempler, & Krajcik, 2006).

As scientific inquiry builds the synergistic relationship, the novice learner potentially develops the skills of the expert researchers. These skills lead to a deeper understanding of the technologies, techniques, and analytical skills of the experts. Traditional instruction gives way to technology-assisted inquiry learning environments. The use of technology has been shown to address common barriers of learning and to present an advantage in introducing scientific applications in the classroom. The use of technology can address student misconceptions and learning differences, which may include the student’s Prior Knowledge, Learning Preferences and Motivation toward Computer.

The prior knowledge of the learner can be used as a baseline from which to build. At the point of initial engagement, an estimate of a learner’s prior knowledge can be used to gauge a learner’s levels of common knowledge and misconceptions. Pre and post
assessments of knowledge are commonly used to analyze learner’s prior knowledge. Despite some researchers’ beliefs that prior knowledge is of limited significance (e.g., Dubay, 1986, Johnson & Lawson, 1998, McAdaragh, 1981), others believe that prior knowledge can be used in the development and transfer of knowledge (e.g., Donovan and Bransford, 2005; Edelson, 2001; Sawyer, 2006; Siebert & McIntosh, 2001). I used a pre-test to assess learners’ prior knowledge of the cell and to estimate the degree to which they might benefit from their interactions in the inquiry-based learning environment designed for the study.

Apart from prior knowledge, I also chose to examine the interactions of learners’ learning preference between and among variables in the study. There are many instruments for measuring Learning Preference (e.g., Fleming, 2006; Kolb, 1984, Tanner & Allen, 2004), with no one is superior to the other. Each instrument gives learners a better understanding of their personal requirements for learning and can suggest needs for adaptability. Individual learning preferences with use of technology can assist students in adapting to scientific situations (e.g., McAndrews, Mullen, Chadwick, 2005; Tanner & Allen, 2004). Instrumental presentation that caters to all students is a daunting task, but technology–supported inquiry learning has the capability to empower a diversified group of learners in the scientific classroom (Fleming & Mills, 1992) which content and experience can be manipulated despite their learning preference.

The final learner characteristic I chose as potentially affecting learners’ abilities to interact with the designed learning environment was one of motivation, specifically, motivation towards the use of computers and technology. Previous research (e.g.,
Blumenfeld et al., 1991, Bransford et al., 2000, McAndrews, Muller & Chadwick, 2000) led me to understand that the addition of computer technology to the learning environment required me to assess learner’s motivation about the use of technology in this study. Research has shown the use of technology has the ability to present concepts often unavailable to undergraduate learners due to underlying barriers such as cost, availability and class size (Edelson, Gordon & Pea, 1999; Buckholt et al., 2003). As learners interacted within the technology-driven, inquiry-learning environment designed for this study, I hypothesized connections between learners’ motivation to participate and use the programming in gauging their conceptual understanding resulting from learning in that environment.

**Outcomes: Inquiry Task Performance and Conceptual Understanding**

In reviewing the dependent variables, I related the learner’s characteristics to the use of the *ER Project* and the ability to gain understanding of the cellular concepts. This understanding is based on the use of an inquiry environment with the assistance of technology.

Multiple instructional methods (e.g., Edelson et al., 2006; Gabel, 2003; Lawson, 2001; Novak, 2002) are suggested for developing conceptual understanding of learners. Of the methods suggested, the *ER Project* focused on the combined use of inquiry and technology. The use of inquiry has been one of the pivotal methods suggested in reforming educational scientific instructional methods (e.g., see National Research Council, 2003; American Association for Advancement of Science, 1993; Bransford, Brown & Cocking, 2000). In our design of the *ER Project*, we aspired to give learners
the environment to simulate the thinking process and analytical skills practiced by scientific researchers (e.g., see Blumenfeld, Kempler, & Krajcik, 2006; Kozma, 2000; Bransford et al., 2000).

The addition of technology provides the ability to scaffold (Lee & Songer, 2003; Trinadade et al., 2002) skills learners can replicate (American Association for Advancement of Science, 1990) of scientists’ views of evidence, logic, and imagination, while trying to explain and predict new phenomena. Research has shown that technology can have a positive influence on the learner’s development of scientific skills (e.g., see Edelson et al., 2006; Gordin, Polman & Pea, 1994; Howard & Miskowski, 2005; Kozma, 2000; National Research Council, 1996).

Chapter III detailed the design of the research framework, which relied on recent works by Donovan and Bransford (2005), Edelson et al., (1999), and Chinn and Malhotra (2002). Taken collectively, these three sources focused the design of this empirical effort, which was designed to evaluate the effectiveness of a technology-supported inquiry environment by (1) investigating the simple relationships among student learning variables, inquiry performance, and conceptual understanding; and (2) determining the interactions between and among learners’ characteristics, inquiry learning, and learners’ conceptual understanding. Chapter III established the statistical methods to (1) describe simple relationships among variables (i.e., through the use of descriptive statistics and correlation techniques), and (2) determine the nature of the interactions between and among those same variables (i.e., through path analysis). The previously mentioned characteristics of learners (Prior Knowledge, Learning Preference, and Motivation for
Computers) were assessed in relation to the learning that occurred among undergraduate biology students engaged in the *ER Project*. These learner characters were used as predictors of learners’ conceptual understanding of scientific reasoning processes and cellular structure. I made conclusions regarding the relationships among these predictor variables by calculating descriptive statistics and correlations between and among these predictor variables with the dependent variables in the study.

Chapter IV presented the data analysis in two parts. First, the results of evaluating the relationships among variables were presented. The data were collected in four instruments (VARK, CAQ, Pre-Test / Post –Test, Rubric). The VARK(*Visual, Aural, Read/Write and Kinesthetic*) was designed to evaluate students’ learning preferences. The VARK used 13 questions to identify students’ learning preferences. As the learning environment in this study was interactive, technology rich, and open ended, I predicted that learners with visual learning preferences would achieve deeper conceptual understanding than learners who preferred to learn through other modalities.

The CAQ (*Computer Attitudes Questionnaire*) was designed to measure the learner’s interaction and integration of technology into their instruction and operation. The CAQ contained 80 questions requesting students’ attitudes regarding the following subscales: motivation, anxiety, enjoyment, study habits, empathy, computer importance, and email. As technology is an integral part of scientific research and development, the *ER Project* involved the interaction with analytical software and cellular imaging, requiring the observation of the learner’s interaction with technology. I focused on students’ motivation toward computers usage and their anxiety with computer usage. I
predicted conceptual understanding would increase as students’ motivation increased and their anxiety decreased.

Comparisons of pre- and post-test measures revealed gains in content knowledge. The content knowledge pre-test contained 50 questions, which provided a baseline for what the learners brought to the project; the post test measured any change from the initial test. I predicted that learner’s conceptual understanding would increase with their use of the ER Project.

Inquiry Task Performance on the ER Project was measured by a rubric. The rubric observed the learners’ ability to connect concepts and analyze the ER Project. The Inquiry Task Performance rubric contained 5 categories: (1) Generating Questions, (2) Model/Analogy, (3) Analysis, (4) Synthesis and (5) Final Product. The ER project’s simulation of cellular image analysis and open-ended questioning provided the opportunity for learners to participate in an inquiry environment.

In addition, the descriptive statistics of the instruments and a correlation matrix of the predictor variables were derived. Of particular note in the findings related to this first part of the study were the correlations between Prior Knowledge, Learning Preference (Visual, Auditory, Reading/Writing, Kinesthetic), Attitudes Toward Computers (Motivation, Anxiety) Inquiry Performance Task, and Conceptual Understanding. These findings will be discussed in this final chapter.

The second part of the analysis resulted in the development of a causal model depicting the relationships among and between learners’ predictor variables, their inquiry task performance, and their ultimate conceptual understanding. The predictor
variables in the hypothesized model were chosen by reviewing the Adjusted $R^2$ and Beta weights, which contributed to the development of the path diagram for the study (see Figure 8). Note in Figure 8 the hypothesized relationships between Prior Knowledge, Auditory Preference, Motivation Towards Computers, Inquiry Task Performance, and Conceptual Understanding.

![Path Diagram](image)

Figure 8. Simplified Model for Conceptual Understanding with the Meditative Inquiry Task Performance and Predictors

Within the final section of this chapter, I will (a) discuss and draw conclusions from the results of the research, (b) examine the implications of the results, and (c) recommend directions for further study.
Prior Knowledge

Overview

Prior Knowledge was applied to the framework of this module because it was discussed as an essential component in identifying learners’ inquiry skills and conceptual understanding. The learner-centered nature of the ER Project and the basis that all of the students are upperclassmen required a need to take in consideration their Prior Knowledge, particularly in that previous research has shown that learners bring experiences into their instruction that contribute to their engagement of the situation. In the project Prior Knowledge was seen as the base line of change in the student’s actions as they were working with the ER Project. The evaluation of the learners’ Prior Knowledge was achieved by administering a pretest before students’ engagement in the ER Project. The learners were asked questions related to cellular structure, interaction and movement. The prior knowledge variable was used to calculate the variances shared in the relationships of learners’ prior knowledge, inquiry task performance and conceptual understanding.

Discussion of the Questions I and II

In Question I, Prior Knowledge was hypothesized to have a relationship with Conceptual Understanding and the Inquiry Task Performance. The correlation between Prior Knowledge and the dependent variables was observed by evaluating the correlation coefficient. The adjusted R², beta weights and structure coefficients were used to identify the best variables for the path diagram despite the class size.
In Question II, the relationship of the Prior Knowledge path toward Conceptual Understanding and Inquiry Task Performance was measured by the path coefficient. Goodness of fit values was also considered for all the predictor variables.

Discussion of the Results

Results for Question I testing for Prior Knowledge had a strong correlation with Conceptual Understanding but it had a limited correlation with the ER Project. The data showed that the Prior Knowledge correlation with Conceptual Understanding was $r=0.81$; a moderately negative relationship with the Inquiry Task Performance of $r=-0.33$. The observation of the following contributed to determining the best group of predictor variables: Adjusted $R^2=0.062$, the beta weight $=-0.34$ and the structure coefficient in Table 5.

In observing Prior Knowledge in the path diagram, it had the strongest coefficient among the predictor variables and dependent variables. The positive relationship with a beta weight of 0.97 between Prior Knowledge and Conceptual Understanding. While the path value between Prior Knowledge and Inquiry Task Performance was -0.10, indicating a weaker relationship than the previous discussed.

Conclusion

The findings of this study were consistent with previous research stating that the use of a pre-exam can evaluate the amount of content knowledge the learners bring to their learning environment. The project also showed that using pre and post exam is not the most effective method to measure the learner’s Inquiry Task Performance. This may be contributed to the fact that the module contained sufficient content to engage the
learners in the *ER Project*. Also, due to the fact that the students were junior and seniors the amount of prior knowledge they had from previous coursework compensated for the module’s content. Each of the subjects in this study was either a junior or senior student who had already met the prerequisites of the biology course. The *ER Project* focused more on the inquiry skills of the learner, so that content already learned could be transferred. Students’ performance on the pre-exam showed that the learners were familiar with the content.

**Learning Preference**

*Overview*

The four learning preference characteristics of interest were visual, auditory, reading/writing and kinesthetic. As learners are engaged with the *ER Project* they use their personal learning characteristics to interact with the inquiry environment. The *ER Project* is composed of components of visualization, auditory, reading/writing and kinesthetic. The observation and measurement of the learner’s interaction with the *ER Project* hoped to identify the most beneficial.

*Discussion of the Questions I and II*

In Question I, Visual, Auditory, Reading/Write, and Kinesthetic (VARK) learning preference variables were hypothesized to have a relationship with Inquiry Task Performance. The correlation coefficient was used to select the best learning preference predictor variable. The beta weight, adjusted $R^2$, and structure coefficient were used to evaluate the relationship among the learning preference variables with Inquiry Task Performance in order to reduce the number of variables. (Sample size required a reduction in the number of variables.). In Question II, the chosen learning preference
variable was placed in the path diagram because of the stronger relationship of the path coefficient for the specific learning preference variable with Inquiry Task Performance.

**Discussion of the Results**

Results for testing Question I showed the relationships of the VARK predictor variables and Inquiry Task Performance. The data showed that Auditory Learning Performance displayed the strongest relationship with Inquiry Task Performance. The correlation coefficient was -0.34, in comparison to other correlation coefficients that ranged from 0.24 to 0.14. The earning reference predictor variable showed had the highest auditory learning preference, with an adjusted R^2 = .129; beta weight = .287; and structure coefficients. The observation of the following factors in addition to the correlation coefficient identified Auditory Learning Preference as a predictor variable. The introduction of the Auditory Learning Preference variable in the path diagram, presented a path coefficient of -.84. The inverted relationship showed that students with low Auditory Learning Preference had higher scores on Inquiry Task Performance.

**Conclusion**

Auditory Learning Preference was identified as a logical predictor of the learner’s characteristics in relation to Inquiry Task Performance, as one could say that there was a limited need for auditory communication in students’ engagement with the ER Project. While the ER Project did require collaboration among the students, this element was not measured as the students developed analogies to explain intercellular structure and function.
Motivation toward Computers

Overview

Learner’s Attitude Toward Computers focused on the learner’s interaction or use of technology. Learners’ motivation and computer anxiety became points of interest in this study because of the large amount of time learners required for learners to work with computers, video software, and image databases. Learner’s attitudes could logically contribute either positively or negatively to their Inquiry Task Performance and ultimately to their Conceptual Understanding.

Discussion of the Questions I and II

In Question I, motivation toward computers and computer anxiety was hypothesized to have a relationship with Inquiry Task Performance. The relationship was measured by observing the correlation coefficient. The beta weights, adjusted $R^2$ and the structure coefficient were used to reduce the number of variables by their magnitude of contribution to the relationships.

In Question II, the selected variable of motivation toward computers was inserted into model and observed the path coefficients between motivation toward computers and the inquiry task performance.

Discussion of the Results

Results for Question I testing for Motivation toward Computers and Anxiety toward computers against Inquiry Task Performance had a correlation coefficient of 0.05. Even though the magnitude was small, the relationship was positive. This relationship becomes stronger after observing the beta weight= 0.14, Adjusted $R^2$=0.062
and Structure coefficient seen in Table 4.6 was calculated. In considering the other factors, Motivation toward Computers was chosen, with a path coefficient of -0.20.

**Conclusion**

The negative, low path coefficient between Motivation toward Computers and Inquiry Learning Performance indicates a limited, inverse relationship between learners’ attitudes and their interactions with the ER Project. In other words, as motivation towards the use of computers (Ogu & Schmidt, 2009) increased in the learners in this study, their Inquiry Learning Performance decreased. These results would suggest that learners who are not motivated towards the use of computers should do slightly better on the *ER Project* than learners who are motivated towards the use of computers.

**Conceptual Understanding**

**Overview**

Conceptual Understanding was an outcome variable measuring students’ understanding of cellular concepts and structure after their engagement with the *ER Project*. I hypothesized that students’ Conceptual Understanding would increase for students who scored well on the Inquiry Task Performance measure, which was a measure of their success in engaging in the *ER Project*.

**Discussion of the Questions I and II**

In Question I, Conceptual Understanding was hypothesized to have a positive, direct relationship with Inquiry Task Performance of the ER Project. The strength of the relationship between these two measures was estimated through an examination of the correlation coefficient between the two variables. To test Question II, the strength of the
relationship between Inquiry Task Performance and Conceptual Understanding was measured by the path coefficient.

Discussion of the Results

Results for Question I testing for Conceptual understanding and the Inquiry task performance correlation coefficient was -0.27. The value of the coefficient indicates an inverse, weak relationship between the two variables. Results of the path analysis indicated a path coefficient of 0.03, indicating a weak yet positive relationship between the two variables.

Conclusion

The low path coefficient suggests a limited relationship between student’s performance on the inquiry task and their resulting understanding of cellular concepts and structure. I have to conclude that the use of inquiry as it was presented in the ER Project did not have much of an effect on increasing students’ understanding, similar to Jaakkola, Nurmi, & Veermams, (2010); Mulder, Lazonder & Jong (2010).

Path Diagram

As mentioned in Chapter IV, the path diagram composed of Prior Knowledge, Auditory Learning Preference and Motivation Toward Computers, Inquiry Task Performance, and Conceptual Understanding was analyzed for the path coefficients and the following descriptive fit statistics: Normal Fit Index (NFI), Comparative Fit Index (CFI), Root Mean Square Error of Estimate (RMSEA), Goodness of Fit (GFI) and Adjusted Goodness of Fit (AGFI).
In the observation of these statistics, I found that the first set of predictor variables left room for discussion: most of the path coefficients were significantly low and none of the values met the ideal descriptive fit limits.

Upon analyzing additional variations of the path diagram more fitting values were achieved for the best-fit model. This was achieved by doing the following modification. The exchange of the Auditory Learning Preference variable with the Visual Learning Preference created more ideal values. As seen in Figure 9, the Motivation toward Computers path coefficient increased to 0.99 indicating that, the learner’s Motivation toward Computers could be a predictor of their interaction with the Inquiry Task Performance.

Replacement of Auditory Learning Preference with the Visual Learning Preference variable was a logical change that resulted in agreements within the data, due to the considerable amount of learners’ interaction in the *ER Project* that required visualization. The final model appearing as Figure 9 indicates that learners’ Prior Knowledge of cellular concepts and structure was weakly correlated with their performance on the inquiry task. This finding is understandable for two basic reasons related to (1) the methods by which the two variables were measured (i.e., Prior Knowledge was measured by paper-and-pencil methods and Inquiry Task Performance was measured via rubric) and by the requirements of the tasks (i.e., Prior Knowledge required recall of factual information; Inquiry Task Performance required manipulation of the computer). The positive relationships between Visual Learning Preference and Motivation Towards Computers with Inquiry Task Performance are also logical, in that
the performance on the inquiry task required visual skills to manipulate variables on the computer. Finally, relationships of Prior Knowledge and Inquiry Task Performance with Conceptual Understanding are also logically consistent. Research (e.g. Zacharia, 2007) in the learning sciences consistently supports positive relationships between measures of prior knowledge with measures of knowledge gained through innovative interventions. What is more difficult to understand is the negative correlation of Prior Knowledge with Inquiry Task Performance, indicating that what individuals knew coming into the inquiry task actually hindered their performance on the inquiry task. Even with the negative effects of prior knowledge on task performance, the relationship between task performance and Conceptual understanding was still positive, but very weak. These
results lead me to consider again the importance of the measures chosen or designed to operational variables.

**Discussion and Implications**

The use of inquiry environments and technology in the classroom has been instrumental in initiating discussion of reform and growth in science curriculum and instruction. As students continue to become more technology savvy and their content knowledge increases, learning environments must also evolve to provide additional supplements within the instruction. The data from this study produces multiple implications for the use of interventions like the *ER Project* to supplement instruction. These implications focus on the evidence from this study that indicates that relationships exist between learners’ learning preferences and attitudes towards computers, as well as their prior knowledge, in assessing (e.g. Quellmalz & Kozma, 2003) students’ abilities to complete computer-mediated inquiry tasks and learn information more effectively.

While the results of this study indicate the power of students’ prior knowledge (Polacek & Keeling, 2005) in predicting their new knowledge, the results of this study do not indicate that students’ prior knowledge has any effect on their performance on a technology-mediated inquiry task. As a matter of fact, a negative relationship between students’ prior knowledge and their performance on the inquiry task indicates that perhaps skills other than those associated with faculty knowledge were involved in inquiry task performance, to such an extent that students with higher knowledge performed worse on the inquiry task than students with lower levels of knowledge.
With the employment of path analysis and subsequent removal of variance due to the prior knowledge variable, relationships were positive between visual learning preference and motivations towards computer, indicating that personological variables of the learner should be considered when providing students with innovative curriculum models, such as the *ER Project*.

Anecdotal observation data of students working with the *ER Project* indicated multiple benefits in training learners in skills related to practices of scientists. As the learner interacted with the *ER Project*, I observed that students developed questions of their own personal interest in their use of the ER database and that they developed methods for using the database to answer their own questions. Finally, students were able to communicate their findings in video format. These are skills that can be implemented in other classroom projects and discussions that require collections of images of any interest. These finding are in line with the benefits other researchers found in their use of technology support inquiry environments (e.g. Khan, 2010; Hsu & Thomas, 2002).

When teachers are using technology in the classroom they need to take in consideration the learners personal characteristics. Despite the commonality of technology in society there are still learners who are challenged with its use. Often students will not understand the reasons behind the project causing them to reduce their enthusiasm or focus in their work. But on the other hand, the use of technology that incorporates science themes is a medium that can exploit interest. I feel the project
showed that there might be other predictors that may provide better information about individual learners’ usage of innovative materials.

In conclusion, Motivation toward Computers (eg. Edgcomb, Britner, McCannawghay & Wolfe, 2008) stood out as a predictor variable in an inquiry based learning environment. The Learning Preference variable was not a strong predictor, leaving me to look for additional predictors. In spite of the low contributions of the Learning Preference variable in predicting Inquiry Task Performance, the positive relationship between the measure of their Motivation towards Computers and their Inquiry Task Performance indicated that learners understood the scientific processes and were able to communicate their results.

**Future Recommendations**

Future projects will seek to evaluate the assessment, the structure of the *ER Project* and alternate predictors. Recommendations that follow are based on the design of studies that modify the original study described here.

**First Recommendation**

I would look into alternative predictor variables that may give a more efficient identification of positive interaction in an inquiry environment.

**Second Recommendation**

I would gather more data on the individual learners. This would include deeper investigation into their scientific backgrounds. I would also change from the VARK learning preference instrument. The alternative would focus more on science learners, such as the Dimensions of Learning Preference in Science (Felder & Silverman, 1988).
This instrument has five subscales: (1) Sensory/Intuitive, (2) Visual/Verbal, (3) Inductive/Deductive, (4) Active/Reflective, and (5) Sequential/Global. The research findings regarding the use of this instrument have shown that good learners are sensory, visual, inductive and active. Use of this instrument could provide more insight regarding the influence of students’ learning preferences on their engagement with the ER Project.

Third Recommendation

I would focus more on the scientific skills and inquiry skills of the learners. The development of the video illustrated the learner’s analytical ability and transfer of information. I would like to evaluate each of the categories separately that composed the rubric score. Each category showed a probability of correlation with the conceptual understanding. The five categories were (1) Generating Questions, (2) Model/Analogy (3) Analysis, (4) Synthesis and (5) Video Product. I would recommend completing separate analyses of these categories and their relationships with Conceptual Analysis rather than the use of the total rubric score, which might indicate areas for improvement of the ER Project with future learners. When I began the project, the focus was on the improvement of learners’ understanding of cellular structures and movement, but as the project evolved I saw that learners’ performance in completing the inquiry task required a variety of skills and abilities, rather than a global, holistic “performance” measure. Different learners appeared to experience barriers with different tasks in completing the entire performance. My informal observations of learners working within the context of the ER Project led me to new understandings about the whole concept of “inquiry task performance.” As a result, I would treat the variable differently in subsequent studies.
and attempt to tease out specific skills and abilities that may enhance or hinder students’ success in completing the task as well as subsequent conceptual understanding of cellular structure and concepts.

Fourth Recommendation

This recommendation focuses on the examination of individuals’ interactions with the ER Project, rather than just relying on collaborative group interactions. I have come across software that will video record the group’s actions and discussion but also record learners’ interactions with the ER Project interface on the computer. This would provide an opportunity to see the division of the individual and group interaction with the ER Project and to see the most challenging parts of the ER Project from the learners’ perspective.

Fifth Recommendation

I will reduce the number of variables with each phase of evaluating the ER Project and look for an ideal class size for the application of the analysis. While recommendations of optimal numbers of variables and subjects vary, the number of subjects I had in this preliminary, exploratory study was too small, which considerably limited my abilities to use path analysis with multiple variables as my major statistical strategy to assess the strength of relationships between and among a number of variables.

Sixth Recommendation

The Pre and Posttest will be delivered to the learners in the same method over the same period of time.
Seventh Recommendation

I would like to add a survey to evaluate the conceptual understanding and the student’s personal thoughts about the ER Project.
REFERENCES


Ontario. BC Decker.

Novak, J.D. (2002). Meaningful learning: the essential factor for conceptual change in limited or inappropriate prepositional hierarchies leading to empowerment of learners. Science Education. 86, 548-571.


Supplemental Sources Consulted


APPENDIX A

PRE-POST EXAM

ID: ____________________________

1. Biologist continue the Human Genome Project, to unlock secrets of ____, in order to know new medical treatments.
   A. Proteins
   B. Mitochondria
   C. Cell membranes
   D. DNA
   E. Ribosomes

2. The function of the plasma membrane is to:
   A. Serve as a highly selective barrier
   B. Completely isolate the cell from the external environment
   C. Equalize the chemical composition inside and outside the cell
   D. Regulate the intake of nutrients and the excretion of waste
   E. Both A and D

3. It is advantageous for cells to be small because
   A. A small cell size prevents a cell from weighing too much
   B. A small cell size occupies less space in nature where space is limited
   C. A small cell has a small volume relative to surface area, thereby increasing efficient transport
   D. A small cell has a small surface area relative to volume, thereby facilitating ion balance
   E. A small cell is better able to conserve energy than a larger cell

4. One strategy that allows larger cells to have an effective surface area to volume ratio is:
   A. Having a completely spherical shape
   B. Being short and fat
   C. Having thin, fingerlike microvilli projections
   D. Having a thinner plasma membrane
   E. Locomotion

5. Which of the following is not an example of homeostasis?
   A. a cell maintains a constant pH
   B. a cell maintains a constant glucose concentration
   C. a cell maintains a constant salt concentration
   D. a cell maintains a constant water concentration
   E. all of the above are examples of homeostasis

6. The ratio of the size of the image seen with the microscope to the actual size of the object is:
   A. Magnification
   B. Resolution
   C. Resolving power
   D. Centrifugation
   E. None of the above

7. Electron microscopes have a much higher resolution than wither the human eye or any light microscope because:
   A. Of their higher magnification
   B. The lenses used are higher quality
   C. Of the very short (nanometer) wavelengths of electrons
129

D. The images are viewed on screens, rather than directly using an eyepiece or ocular
E. All of the above

8. The advantage of studying cells using a phase contrast microscope is that:
   A. The magnification is greater
   B. The resolving power is greater
   C. It is faster
   D. It permits us to view internal structures of living cells
   E. It uses a beam of electrons to allow the organelles enclosed by the plasma membrane

9. Which cell structure would not be in a prokaryotic cell, but would be found in a eukaryotic cell?
   A. Cell wall
   B. Flagellum
   C. Ribosomes
   D. Golgi complex
   E. DNA

10. The scanning electron microscope differs from the transmission electron microscope in that the
    scanning electron microscope:
        A. Can view a live specimen
        B. Relies on the detection of electrons from the beam after contact with the specimens
        C. Can view the internal structure of a cell
        D. Utilizes a beam of light that passes through the specimen
        E. Gives a three dimensional image of the outer surface of the object being studied

11. Membranes facilitate all of the following except:
    A. Facilitating the formation of energy-yielding gradients
    B. Acting as barriers to ions
    C. Acting as important “work benches” within cells
    D. Directing the synthesis of proteins
    E. Maintaining the identity of different cellular compartments

12. Which of the following structures or activities is not directly part of the endomembrane system?
    A. Budding
    B. Lysosomes
    C. Ribosomes
    D. Peroxisomes
    E. Golgi complex

13. DNA is associated with histone proteins during interphase forming a complex known as:
    A. Chromosomes
    B. Nucleoli
    C. Nucleus
    D. Genes
    E. Chromatin

14. Nucleoli contain DNA genes that have the code for:
    A. Proteins
    B. mRNA
    C. Ribosomal RNA
    D. Lipids
    E. Hormones

15. If a toxin, such as bacterial toxin, destroys ribosome, what cellular activity will be affected first?
    A. Protein synthesis
    B. DNA synthesis
    C. Movement
    D. Energy storage
    E. Active transport

16. The smooth endoplasmic reticulum
    A. Is absent in most plant cells
B. Synthesizes proteins  
C. Provides structural support  
D. Synthesizes lipids  
E. is required for ribosome synthesis

17. Which of the following pairs is correctly matched?  
A. Chloroplast – storage of enzymes  
B. Lysosome – powerhouse of the cell  
C. Nucleolus – site of ribosomal subunit synthesis  
D. Plastids – structural support of the cell  
E. Golgi complex – production of energy

18. Which of the following organelles plays an important role in apoptosis, or programmed cell death?  
A. Lysosome  
B. Mitochondria  
C. Chloroplast  
D. Vacuoles  
E. Peroxisomes

19. One function of peroxisomes involves the process of:  
A. Cell death  
B. Water storage  
C. Protein synthesis  
D. DNA replication  
E. Detoxification

20. During an infection, white blood cells travel to the infected site and phagocytize the pathogens. After phagocytosis, primary lysosomes fuse with the phagocytic endosome vesicle to form a larger vesicle called a secondary lysosome. The reason for this is:  
A. To introduce antibodies to the phagocytic vesicles  
B. To wrap the pathogen in additional membrane, rendering them harmless  
C. To coat the bacteria in lipids derived from the Golgi complex, which cover and smother them  
D. To mix the pathogens with strong hydrolytic enzymes and destroy them  
E. To prepare the bacteria for export from the body

21. All of the following functions are performed by plant vacuoles except:  
A. Maintaining hydrostatic (turgor) pressure  
B. Waste storage and recycling  
C. Storage of proteins  
D. Breakdown of unneeded cellular materials  
E. Storage of nucleic acids

22. A cellular structure found in plant but not animal cells is the:  
A. Chloroplast  
B. Ribosome  
C. Endoplasmic reticulum  
D. Microtubule  
E. Microfilament

23. Which of the following is a key component of the cytoskeleton?  
A. Microfilaments  
B. Microtubules  
C. Intermediate filaments  
D. All of the above  
E. Endoplasmic reticulum

24. The force necessary to cause microtubules of cilia and flagella to slide alongside one another is provided through the action of _____ proteins, which derive the energy to perform their work directly from _____ molecules.
A. Kinesin; ADP
B. Kinesin; glucose
C. Tubulin; ATP
D. Dynein; ATP
E. Dynein; glucose

25. All living organisms possess:
   A. Photosynthesis
   B. Cellular organization
   C. Growth and metabolism
   D. Reproduction and heredity
   E. Only B, C and D

26. Small cells function more effectively, because as cells become larger the surface area to volume ratio:
   A. Increases
   B. Decreases
   C. Stays the same
   D. Is squared
   E. Is cubed

27. Membrane-bound organelles that contain enzymes that can catalyze the breakdown of pathogenic bacterial cells are known as:
   A. Lysosomes
   B. Plastids
   C. Vacuoles
   D. Liposomes
   E. Ribosomes

28. The proteins of the plasma membrane are in the large part responsible for the cell’s ability to interact with its environment. They act as or are involved in all of the following except:
   A. Forming channels for transporting ions in or out of cells
   B. Receptor recognition of specific molecules
   C. Membrane signal transduction
   D. Transport of ions, molecules in and out of cells
   E. Packing of DNA (histones)

29. Prokaryotic cell movement is attributed to the:
   A. Capsule
   B. Ribosomes
   C. Pili
   D. Nucleoid area
   E. flagella

30. Plant cells often have a large membrane-bound sac that is used for storing water and other substances. This organelle is called:
   A. Nucleus
   B. Chloroplast
   C. Golgi body
   D. Centriole
   E. Central vacuole

31. Which of the following is not bounded by membranes?
   A. Endoplasmic reticulum
   B. Peroxisome
   C. Golgi body
   D. Nucleolus
   E. Nucleus

32. Which of the following is not present in all eukaryotic cells?
A. Endoplasmic reticulum
B. Ribosome
C. Plasma membrane
D. Cell wall
E. Golgi bodies

33. Ribosomes are:
A. Only DNA molecules
B. Only ribosomal RNA molecules
C. Single and circular chromosomes
D. Only ribosomal protein molecules
E. Large molecular aggregates of ribosomal protein RNA

34. Lipid synthesis occurs in which eukaryotic organelle?
A. Rough ER
B. Smooth ER
C. lysosome
D. mitochondria
E. nucleolus

35. In eukaryotes, mitochondria are the organelles primarily involved in:
A. Energy transformation to ATP
B. Phospholipid assembly
C. Export of enzymes
D. Lipid synthesis
E. Protein synthesis

36. Chromatin can be condensed into compact chromosomes which are visible with the light microscope, but usually only:
A. After the cell is dead
B. During mitosis or meiosis
C. While the DNA is being copied into RNA
D. While the proteins are being assembled
E. While the nuclear pores are open

37. Flattened sacks of membranes apparently involved in the packaging and export of molecules synthesized in the cells are known as:
A. golgi bodies
B. microbodies
C. pinocytic vesicles
D. vacuoles
E. chromosomes

38. Lysosomes are vesicles bounded by membranes that contain oxidative enzymes. Their functions include all of the following except they:
A. Catalyze the rapid breakdown of macromolecules
B. Energy transformation to ATP
C. Eliminate substances taken into the cell by phagocytosis
D. Digest phagocytized pathogens
E. Apoptosis or programmed cell death during development

39. Peroxisomes in animal cells, and glyoxisomes in plant cells are examples of:
A. Chromosomes
B. Lysosomes
C. Microbodies
D. Nucleosomes
E. Ribosomes

40. Mitochondria and chloroplasts are the other organelles besides the nucleus that contain:
A. Genes
B. Pores
C. Channels
D. Plasma membranes
E. Pigments

41. The organelle involved in the oxygen-requiring process by which the energy in macromolecules is stored in ATP is the:
   A. Nucleus
   B. Lysosome
   C. ER
   D. Mitochondria
   E. Chloroplast

42. The endosymbiotic theory is supported by the finding of non-nuclear DNA in which of the following organelles?
   A. Lysosome
   B. ER
   C. Mitochondria
   D. Chloroplast
   E. Both C and D

43. The distinctive feature of chloroplasts is that they contain a green pigment called:
   A. Gram stain
   B. Chlorophyll
   C. Hemoglobin
   D. Chromatin

44. The distinctive feature of chloroplasts is that they contain a green pigment called:
   A. Gram stain
   B. Chlorophyll
   C. Hemoglobin
   D. Chromatin

45. The reticulated (net-like) nature of the ER in animals is produced by tubules growing out along the
   A. ER
   B. Golgi
   C. Lysosome
   D. Mitochondrion

46. The reticulated (net-like) nature of the ER in animals is produced by tubules growing out along the
   A. ER
   B. Golgi
   C. Lysosome
   D. Mitochondrion

47. Scientist do not know which of the following:
   A. The driving force for the movement of protein through the tubules of the ER.
   B. Whether materials is transferred to the Golgi plants from the ER by tubules coming directly off of the ER or from vesicles coming off of the ER.
   C. If Golgi and ER can be connected to the same microfilament in plants
   D. All of the above

48. The nuclear envelope is a continuation of the
   A. ER
   B. Golgi
   C. Lysosome
   D. Mitochondrion

49. During division elements of the nuclear envelope are resorbed by which membrane system?
   A. ER
   B. Golgi
C. Lysosome  
D. Mitochondrion

50. The endoplasmic reticulum serves as a reservoir for which ion used in signal transduction?
   A. K+  
   B. Na+  
   C. Ca++  
   D. Mg++

51. What is a modification of the ER at crosswalls in plants that allows plant cells to be connected through the ER?
   A. ER is the middle lamella  
   B. ER is the central membrane system in plasmodesmata  
   C. ER is budded from the plasma membrane  
   D. There is no modification of the ER

52. What kind of motor is there associated with microfilaments?
   A. Dynein  
   B. Kinesin  
   C. Ribozyme  
   D. Myosin

53. What cytoskeleton network drives fast axonal transport in animals?
   A. Microtubule  
   B. Microfilament  
   C. Intermediate filament  
   D. Keratin filament

54. What cytoskeleton network drives fast axonal transport in animals?
   A. Microtubule  
   B. Microfilament  
   C. Intermediate filament  
   D. Keratin filament

55. Golgi track rapidly along what part of the ER in plants?
   A. Fast lanes  
   B. Slow lanes  
   C. Plasmodesmata  
   D. Nuclear envelope
APPENDIX B

VISUAL, AUDITORY, READING/WRITING QUESTIONNAIRE

How Do I Learn Best?

This questionnaire is available online at: http://vark-learn.com/english/page.asp?p=questionnaire

This questionnaire is designed to find out about your preferences for the way you work with information. You will have a preferred learning style, and one part of that learning style is your preference for the intake and the output of ideas and information. Choose the answer which best explains your preference and circle the letter next to it. Please circle more than one if a single answer does not match your perception. Leave blank any question which does not apply.

1. You are about to give directions to a person who is standing with you. She is staying in a hotel in town and wants to visit your house later. She has a rental car. Would you
   a) draw a map on paper
   b) tell her the directions
   c) write down the directions (without a map)
   d) collect her from the hotel in your car

2. You are not sure whether a word should be spelled "dependent" or "dependant." Do you
   a) sound it out in your mind and choose by the way it looks
   b) look it up in the dictionary
   c) write both versions down on paper and choose one

3. You have just received a copy of your itinerary for a world trip. This is of interest to a friend. Would you
   a) show her on a map of the world
   b) phone her immediately and tell her about it
   c) send her a copy of the printed itinerary
   d) share what you plan to do at each place you visit

4. You are going to cook something as a special treat for your family. Do you
   a) thumb through the cookbook looking for ideas from the pictures
   b) give a name to your menu
   c) refer to a specific cookbook where there is a good recipe

5. A group of tourists has been assigned to you to find out about wildlife reserves or parks. Would you
   a) show them slides and photographs
   b) drive them to a wildlife reserve or park
   c) give them pamphlets or a book on wildlife reserves or parks
6. You are about to purchase a new stereo. Other than price, what would most influence your decision?
   b) the salesperson telling you what you want to know
   c) reading the details about it
   d) playing with the controls and listening to it

7. Recall a time when you learned how to do something like playing a new board game. Try to avoid
   choosing a very physical skill, e.g., riding a bike. How did you learn best?
   a) visual – clues – pictures, diagrams, charts
   c) written instructions
   b) listening to somebody explaining it
   d) doing it or trying it

8. You have an eye problem. Would you prefer that the doctor
   b) tell you what is wrong
   a) show you a diagram of what is wrong
   d) use a model to show what is wrong
   d) sit down at the keyboard and experiment with the program's features
   c) read the manual which comes with the program
   b) telephone a friend and ask questions about it

9. You are about to learn to use a new program on a computer. Would you
   d) sit down at the keyboard and experiment with the program's features
   c) read the manual which comes with the program
   b) telephone a friend and ask questions about it
   d) use a model to show what is wrong

10. You are staying in a hotel and have a rental car. You would like to visit friends whose address/location
    you do not know. Would you like them to
    a) draw a map on paper
    b) tell her the directions
    c) write down the directions (without a map)
    d) collect her from the hotel in your car

11. Apart from price, what would most influence your decision to buy a particular textbook?
    d) you have used a copy before
    b) a friend talking about it
    c) quickly reading parts of it
    a) the way it looks is appealing

12. A new movie has arrived in town. What would most influence your decision to go or not?
    b) you heard a radio review about it
    c) you read a review about it
    a) you saw a preview of it

13. Do you prefer a lecturer or teacher who likes to use
    c) a textbook, handouts, readings
    a) flow diagrams, charts, slides
    d) field trips, labs, practical sessions
    b) discussion, guest speakers
APPENDIX C

COMPUTER ATTITUDE QUESTIONNAIRE

Computer Attitude Questionnaire

Name: ___________________________ Grade Level (9-12): _______

This survey contains 7 brief parts. Read each statement and then circle the number which best shows how you feel.

SD = Strongly Disagree  D = Disagree  U = Undecided  A = Agree  SA = Strongly Agree

<table>
<thead>
<tr>
<th>Part I</th>
<th></th>
<th>SD</th>
<th>D</th>
<th>U</th>
<th>A</th>
<th>SA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>I enjoy doing things on a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>2)</td>
<td>I am tired of using a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>3)</td>
<td>I will be able to get a good job if I learn how to use a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>4)</td>
<td>I concentrate on a computer when I use one.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>5)</td>
<td>I enjoy computer games very much.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6)</td>
<td>I would work harder if I could use computers more often.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>7)</td>
<td>I know that computers give me opportunities to learn many new things.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>8)</td>
<td>I can learn many things when I use a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>9)</td>
<td>I enjoy lessons on the computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>10)</td>
<td>I believe that the more often teachers use computers, the more I will enjoy school.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>11)</td>
<td>I believe that it is very important for me to learn how to use a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>12)</td>
<td>I feel comfortable working with a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>13)</td>
<td>I get a sinking feeling when I think of trying to use a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>14)</td>
<td>I think that it takes a long time to finish when I use a computer.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>15)</td>
<td>Working with a computer makes me nervous.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>16)</td>
<td>Using a computer is very frustrating.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>17)</td>
<td>I will do as little work with computers as possible.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>18)</td>
<td>Computers are difficult to use.</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
</tbody>
</table>

(Continued)
<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>Computers do not scare me at all.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>I can learn more from books than from a computer.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Part II**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>I study by myself without anyone forcing me to study.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>If I do not understand something, I will not stop thinking about it.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>When I don't understand a problem, I keep working until I find the answer.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>I review my lessons every day.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>I try to finish whatever I begin.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Sometimes, I change my way of studying.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>I enjoy working on a difficult problem.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>I think about many ways to solve a difficult problem.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>I never forget to do my homework.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>I like to work out problems which I can use in my life every day.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>If I do not understand my teacher, I ask him/her questions.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>I listen to my teacher carefully.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>If I fail, I try to find out why.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>I study hard.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>When I do a job, I do it well.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Part III**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>36</td>
<td>I feel sad when I see a child crying.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>I sometimes cry when I see a sad play or movie.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>I get angry when I see a friend who is treated badly.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>I feel sad when I see old people alone.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>I worry when I see a sad friend.</td>
<td>1...2...3...4...5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*(Continued)*
APPENDIX D

ER PROJECT

©Lawrence Griffing, 2001

Inquiry on the dynamics of the endoplasmic reticulum and Golgi

This is a lab to share current research in plant cell and molecular biology. The data are acquired using confocal fluorescence microscopy to view genetically-modified plant cells. Cellular membrane systems are examined. These membrane systems, the nuclear envelope (NE), the endoplasmic reticulum (ER) and Golgi apparatus (GA) are used by the cell to synthesize, transport, and store protein and polysaccharide, the foodstuffs of human life.

The central question is: How does the organization and connectivity of these organelles change with time? In other words, how do they move? We introduce this question because many texts do not provide an adequate context for visualizing and understanding internal cell motion.

The first part of this project is to provide calibrated data sets and software tools for measuring changes in these organelles in time and space. The movement of the ER and GA occurs over a time scale of seconds and a spatial scale of 10 nm to 100 μm.

The data sets used for comparison (ERD2a) have been published. However, the data mining that is the basis of this image analysis has not been previously reported. Several questions are posed at the end of this lab to determine if, by doing these analyses, they can be extended in ways that have not been reported in the scientific community.

The MOST IMPORTANT part of the lab is to extend the analytical tools to answering new questions and hypotheses that are posed about the supplied data sets. This is true inquiry of the sort that is used by all scientists in making new discoveries.

What we know about the organization of the plant cell and how we know it (Stout and Griffing, 2001).

1. Plant cells in tissues don’t move in relation to each other and therefore maintain a “sidedness” or polarity.

The organization of cells within a tissue is pretty similar for plants and animals. Cells on the outside of a tissue usually have quite a different structure from those on the inside. Furthermore, there is usually differentiation of cells within the tissue so that cells have different structure, sidedness or polarity, depending on their position in the tissue.

A difference between plant and animal tissues is that plant tissue cells are connected by plasmodesmata, tubular extensions of the plasma membrane and endoplasmic reticulum (ER) through the wall of one cell into next. These connections can be seen with light microscopy, fluorescence microscopy, and electron microscopy, Figure 1. Consequently, even though adjacent cells are quite different, they can be intimately linked through their membrane systems. The organization of the ER will therefore depend on the extent of the connection of a cell with its partner (or daughter) cell.

2. Plant organelles can rapidly move in relation to each other and in relation to other cells.

Cytoplasmic streaming is the term used to describe large scale, rapid movements of organelles in plants. As seen with phase contrast microscopy, Figure 2, not all organelles stream. Streaming can reversibly stop and
start without damage to the cell. Many cells when subjected to shock (e.g., exposure to high salt solution, physical pressures) will stop streaming, and resume upon recovery from the stress. The control mechanism for streaming is unknown, but whatever it is, it probably acts globally on the motors that drive streaming, the plant myosins. Myosin is most frequently thought of as the motor that drives the contraction of muscle. Structurally related molecules are the myosin motors that drive organelles around the plant cell. Like in muscle, myosin in plants moves along actin. Actin microfilaments provide the cytoskeleton for organizing cytoplasmic movement.

Different organelles show different kinds of motion. Most unbranched plant organelles, such as chloroplasts, have many copies per cell. Of particular interest is the observation that the Golgi Apparatus (GA) has hundreds of small stacks, or dictyosomes, per cell. Figure 3. Dictyosomes have only recently been shown to stream (Boevink et al. 1998), although it had been proposed a decade before (Griffing, 1988). Chloroplasts, the light harvesting organelles of plants, actively stream in some cells, while in others, remain anchored.

Given the motion of the cytoplasm, how does the cell retain its sidedness or polarity? Rapidly streaming organelles might be “ticketed” to a particular location, but such ticketing mechanisms are only known in plants for distinguishing between different organelle partners, not where in the cell the partners are. There are probably local tissue or environmentally-determined regions where moving organelles stop moving, thereby becoming localized. For example, chloroplasts in some plant cells can stream to regions of high light and then become immobilized. Branched organelles anchored into the tissue or wall might provide a more global, polar or
3D and 4D Visualisation of Cells

3. Cytoplasmic motions are organized around and through the vacuole in thickenings that contain actin bundles.

The area adjacent to the plasma membrane and cell wall is called the cell cortex. Figure 4. The cell cortex is bordered on the outer surface by the plasma membrane and on the inner surface by the vacuolar membrane. This region contains thinned regions centered around actin and ER bundles and very thin regions that contain separate strands of actin and a polygonal ER tubule network.

The cortical thickenings can separate from the cortex and move into the vacuole, Figure 4. They then become transvacuolar strands surrounded by vacuolar membrane. Consequently, the vacuole can be topologically complex and is highly branched, although the branches appear as a network of tubules within the organelle. Therefore, motion of the vacuole is movement and branching of these transvacuolar strands. Transvacuolar strands are not obvious in cells conventionally prepared for electron microscopy, but can be clearly seen when the cytoplasm is labeled with fluorescence, Figure 5.

4. Cortical thickenings and transvacuolar strands are often sites of rapid movement and have been called "fast lanes" of cytoplasmic streaming.

Organelle movement can occur anywhere in the cell cortex. Images of cortical movement show that much of the directed motion occurs along "lanes," Figure 5, which we will call "fast lanes" for convenience. The term indicates that organelles move faster there, but it turns out that, although they do
1D and 4D Visualization of Cells

generally move faster there, there are conditions when these fast lanes become congested and slow movement occurs. Alternatively, there appear to be regions where fast, directed motion occurs outside of cortical thickening or cytoplasmic strands, but these events are relatively infrequent.

The branching structure of the ER appears to correlate with these fast and slow lanes, with its tubules more bundled in regions of fast lanes and less bundled, with regions of polygonal tubules, in slow lanes, Figure 6. These observations can be made using the first data set that we share.

The shared data are confocal fluorescence images of moving ER, GA, and nuclei.

The cells used for these studies are genetically modified. All of them produce, or express the gene for, a fluorescent protein, green fluorescent protein (GFP), that has been targeted to the organelles of interest using a molecular tag fused to the GFP, Figure 7.

The data set is of a tobacco leaf cell that is expressing GFP in both the ER and GA. The cell was mounted on a slide under a coverslip and images of a single region of the cytoplasm were acquired over time. The microscopy technique is confocal fluorescence microscopy. Fifty-five images were acquired over a period of about 90 seconds. These images can be played back as a movie file, Figure 8a.

**Analysis of ER and GA movement.**

The hypothesis being tested in the following example is: Is there more branching of the ER in fast lane regions than in slow lane regions of the cell cortex? The model for asking this question is that the ER looks like a transit system of high speed and low speed roads. In most transit systems, high speed roads have many fewer access points than
low speed roads. The rationale for all hypotheses is usually based on some model that the scientist is testing. In this case, our model is that the ER system is analogous to a road network.

It is important to stress that the outcome of these measurements are currently unknown however, the hypothesis is a good one because a negative result is not meaningless (often the problem with non-robust hypotheses). Less branching in regions of the fast lanes could be interpreted as a higher stability or slower exit rate of tubules from the tubulin bundle.

To test this, an image-based criterion needs to be established for what comprises fast and slow lane regions. This is done using an "only see what moves" protocol, like the Tyrannosaurus rex in Jurassic Park. As shown in Figure 8b, subtracting sequential frames and setting all negative values to zero results in a difference image of only the features in Frame 2 that moved. After doing this at several time points, all of the times points can be added together to make a final image. If the particle is moving slowly, non-overlapping long sequences result, Figure 8e. If the particle is moving quickly, non-overlapping short sequences result, Figure 8d. This technique is used to together all of the moving regions of the movie, allowing us to directly visualize motion in a single frame. Those with features as in Figure 8e would be identified as fast lanes and the surrounding region chosen for examining branch points during the time over which the fast lane exists. Those areas with blurred, overlapping, and faint movement would be slow lane areas and branches of ER in those regions are counted in the individual frames representing the time when slow lanes existed in that region.

Tutorial for data set analysis.

1. Playing back sequences in Image J, Figure 9.
Figure 10: Setting scale on the calibration image in ImageJ. The values in the Set Scale dialog box have been changed to reflect the measure of the line drawn on the scale bar.

Figure 11: Two open stacks and the image calculator dialog in ImageJ. In this example, stack ended is being subtracted from stack ended2.

3D and 4D Visualization of Cells

1. Open Image J
2. File > Import > Image sequence
3. Select Folder (from CD or download) ERD2A; open tiff folder; click on first image.
5. When images open, paging through the sequence using the right arrow at the bottom of the image plays the movie.
6. Calibrating and measuring images in Image J, Figure 10.

a. File > Open
b. Select Folder keys
c. Select ERD2A.tif
d. Draw line with line tool (first box from left in menu bar) stretching from beginning of 25 µm scale bar to end of 25 µm scale bar (64 pixels).
e. Analyzer > Set Scale
f. Set Scale Dialog box: Known Distance, 25, Known Distance, 25, Aspect Ratio: 1, Unit of Length: micrometers. Check Global (sets the same scale to all open images). Click OK.

1. Open stack of images and look at little bar to see that it is now calibrated in micrometers – dimensions: 76.19 x 70.54 micrometers.
2. To test your calibration, measure the diameter of three of the bright spots (GA) on the first image in the stack with the line tool. After each line, select Analyzer > Measure (or the key combination Ctrl+H). After each measurement, a numbered entry will appear with length. That length is in micrometers. They should be about 1.5 micrometers in diameter.
3. Identification of movement "lanes" - Constructing a "T-Rex" (difference image) sequence in Image J. Only the moving things can be seen. Figure 11!! Figure 12!!
4. Close old stack of images (click upper
1. Open new stack of images. File>Import>Image sequence.
2. Open folder endstack1 and select first image (SERD2A00.tif) and click OK.
3. Select File>Save to Save stack as end2a1.tif.
4. Open another stack of images. File>Import>Image sequence.
5. Open folder endstack2 and select first image (SERD2A01.tif) and click OK.
6. Select File>Save to Save stack as end2a2.tif.
7. Subtract end2a1 from end2a2 from sby selecting Process>Image Calculator.
8. In the image calculator dialog box, Scroll to end2a2.tif for Image 1, scroll to Subtract for operation, and scroll to end2a1.tif for Image 2. Check create new window. Click OK.
9. A question will prompt you if you want to process all 25 slices. Select yes.
10. With the results window open, select Image>Stacks>StackXZ project.
11. In the dialog box, use the defaults (25, 1 and average intensity) and click OK.
13. Select Image>Lookup Table>Red/Green. Fast lanes are green, slow lanes are red, as in Figure 12. Save as red_project.tif.

4. Identifying fast lane regions in difference image. Figure 13a.
   a. Open red_project.tif.
   b. Select the right fast lane using the polygon tool (second selection on menu bar). An example is shown in Figure 13a.
   c. Set which measurements to get from the measurement area by selecting Analyze>Set Measurements. Check the Area and mean gray value boxes.
   d. Obtain the measurement for the area in the results box by Selecting Analyze>Measure.
3D and 4D Visualization of Cells

c. Save measurement results by selecting File>Save As>Measurements, saving it as Area1.txt.
d. Save the selection as a region of interest by selecting File>Save As>ROI. You can name it polygon1.
e. Select a slow lane region with the polygon tool.
f. Measure it using by selecting Analyze>Measure.
g. Save measurement results by selecting File>Save As>Measurements, saving it as Area2.txt.
h. Save the polygon selection (File>Save As>ROI). You can name it polygon2.

6. Outlining the fast lane region of interest on certain parts of the stack
a. Open end2a.tif (stack).
b. Smooth (Process>smooth) and then sharpen (Process>sharpen) the entire stack to remove noise.
c. Increase the contrast of the stack. Image>Adjust>Brightness and Contrast.
d. In the example, set the lower bound of the brightness and contrast box to 13 and upper to 101 using the sliders.
e. Convert the stack to a new type. Image>Type>RGB Color
f. Open polygon1 ROI.
g. Select Image>Colors to give a color palette for drawing the ROI on each image.
h. Select the eyedropper tool and click on the red color.
i. Draw a red outline of the polygon to Images 1-13 in the end2a stack by using the Image>Drawing command (Ctrl+D) key combination, on each of the images as you cycle through them using the arrow in the lower right of the

Figure 14. Example image with outlined fast and slow lanes and triple junctions marked with different color marker tool.
7. Outlining the slow lane region of interest on certain parts of the stack.
   a. Open polygon2 (slow lane) ROI.
   b. Select the eyedropper tool and click on the yellow color.
   c. Draw a yellow outline on each of the first 13 images of the erd2a1 stack (as in f).
   d. Save the stack with fast lane and slow lane outlined as ROIPolygons.
      (File>Save As>Tif>ROIPolygons.tif), Figure 14.
8. Quantifying branch points of the ER fast lane.
   a. Open the dialog box for the point tool: Edit>Options>Point tool
   b. Make the point tool 3 pixels and check Automeasure.
   c. Select the point tool in ImageJ - ninth menu bar tool.
   d. Select a new color using the eyedropper (dark blue)
   e. Click on each triple junction in the fast lane area in the first 13 images. An entry in the results box comes up each time you click.
   f. Save those results as fasttriple.txt. There should be about 126 points counted.
9. Quantifying branch points of the ER in slow lane regions.
   a. Select a new color using the dropper tool (light blue)
   b. Click on each triple junction in the slow lane area using the point tool.
   c. Save those results as slowtriple.txt. There should be about 140 points counted on the example set.

Count the number of junctions in the fast lanes and slow lanes in each image in the stack and give the final measurements to the TA.

Develop and test a NEW HYPOTHESIS using this dataset.

Now that you have gathered the data to test the hypothesis that slow lanes have more branch points that fast lanes - DO THEY?
Now that you have answered this hypothesis using image analysis, you need to come up with YOUR OWN on this data set, ERD2a, or on the alternative data set, ERD2b, or with data from the confocal demo next week. The confocal demo will be of KDEL-GFP and will be able to simultaneously acquire a DIC image and a confocal fluorescence image. You could determine if other organelles besides Golgi move on fast lanes. The hypothesis should be based on a model (like the road traffic analogy for more branches in slow lanes) that is explicitly stated. Once the model is explicitly stated, state the hypothesis clearly. Finally, describe how you are going to test your hypothesis.

Below is one more technique for quantifying movement within the lanes, which might be useful for you if you ask questions about rates of movement in the move.

1. Marking movement in “fast lanes”.
   a. Open erd2a1.tif. Make sure it is calibrated in micrometers (check information below title bar) and convert it to RGB mode if it is not already (Image> Type> RGB)
   b. Use the point tool (colored red) in ImageJ to click on the Golgi body with starting coordinates 55.6x39.8 as it moves down the fast lane.
   c. Continue for the next 10 frames. There are 1.54 seconds between each frame (as seen in the key folder, erd2a2.tif).
   d. Save the results as fastlanepept1.txt

2. Marking movement in “slow lanes”.
   a. Keep erd2a1.tif open.
   b. Use the point tool to mark the somewhat dim Golgi body in the chosen slow lane area with starting coordinates 44 x 52.5.
   c. Continue for the next 10 frames.
   d. Save the results as slowlanepept1.txt.

Think of your new model and hypothesis over the week and give it to the TA before next lab.
## APPENDIX E
### INQUIRY TASK PERFORMANCE RUBRIC

**ER Project Evaluation Rubric**  
**Group Participants:**

<table>
<thead>
<tr>
<th>Grade Scale</th>
<th>Generating Question</th>
<th>Model/Analogy</th>
<th>Analysis</th>
<th>Synthesis</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Student(s) posed a thoughtful, creative question that engaged them in challenging or provocative research. The question breaks new ground or contributes to knowledge in a focused, specific area.</td>
<td>Student(s) included an appropriate analogy, which was either unusually original or particularly revealing.</td>
<td>Student(s) carefully analyzed the information collected and drew appropriate and inventive conclusions supported by evidence. Voice of the student writer is evident.</td>
<td>Student(s) developed appropriate structure for communicating product, incorporating variety of quality sources. Information is logically and creatively organized with smooth transitions.</td>
<td>Student(s) effectively and creatively used appropriate communication tools to convey their conclusions and demonstrated thorough, effective research techniques. Product displays creativity and originality.</td>
</tr>
<tr>
<td>3</td>
<td>Student(s) posed a focused question involving them in challenging research.</td>
<td>Student(s) included an appropriate analogy and uses it appropriately i.e. Similarities and differences are explained with respect to the original situation/activity</td>
<td>Student(s) product shows good effort was made in analyzing the evidence collected</td>
<td>Student(s) logically organized the product and made good connections among ideas</td>
<td>Student(s) effectively communicated the results of research to the audience.</td>
</tr>
<tr>
<td>2</td>
<td>Student(s) constructed a question that lends itself to readily available answers</td>
<td>Student(s) included analogy, but it was not used well.</td>
<td>Student(s) conclusions could be supported by stronger evidence. Level of analysis could have been deeper.</td>
<td>Student(s) could have put greater effort into organizing the product</td>
<td>Student(s) need to work on communicating more effectively</td>
</tr>
<tr>
<td>1</td>
<td>Student(s) relied on teacher-generated questions or developed a question requiring little creative thought.</td>
<td>Student(s) analogy is not present.</td>
<td>Student(s) conclusions simply involved restating information. Conclusions were not supported by evidence.</td>
<td>Student(s) work is not logically or effectively structured.</td>
<td>Student(s) showed little evidence of thoughtful research. Product does not effectively communicate research findings.</td>
</tr>
</tbody>
</table>

**Score**

**Evaluator comments/notes:**

Revised from http://cs.ethics.usf.edu/dolce/teach aids/rubric.html
VITA

Cleveland O. Lane, Jr.

P.O. Box 519, MS 2210 Prairie View, Texas 77446
colanejr@gmail.com

Education:
- B.S., Biology, Prairie View A&M University, 1994
- M.S., Biology, Prairie View A&M University, 1996
- PhD., Curriculum and Instruction, Texas A&M University, 2010

Employment
- 2008-Present Lecturer I, Department of Biology, Prairie View A&M University, Prairie View, Texas
- 2008-Present Adjunct Professor, Department of Biology, Lone Star College, Houston, Texas
- 1996-1997 Instructor of Biology, Department of Biology, Prairie View A&M University, Prairie View, Texas
- 1994-1996 Graduate Assistant, Department of Biology, Prairie View A&M University, Prairie View, Texas

Teaching Experience
- 2008-Present BIOL 1054 Anatomy/Physiology I; BIOL 1064 Anatomy/Physiology II; BIOL 2404 Anatomy/Physiology
- 2000-2007 BIOL 1054 Anatomy/Physiology I; BIOL 1064 Anatomy/Physiology II; BIOL 1015 General Biology; BIOL 1113 College Biology; BIOL 1111 College Biology Laboratories
- 1996-1997 BIOL 1113 College Biology; BIOL 1111 College Biology Laboratory

Research Experience
- Information Technology in Science- Science Education Specialist Program- Texas A&M University, College Station, TX
  Graduate Student
- Information Technology in Science- Science Education Specialist Program- Texas A&M University, College Station, TX
  Curriculum Resource Person
  Pathogenesis of Sickle Cell Disease on the Retina- UMDNJ-Newark, NJ
  Research Assistant
- Mycotoxin Production and Oil Degradation- Prairie View A&M University, Prairie View, TX